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Working with Tables and
Mail Merge in MS-Word
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INTRODUCTION

MS Word offers a flexible feature of presenting information in tabular
form. It is very useful in organizing and representing the data in an effective
way. A table consists of a number of columns and rows. In this chapter we will
learn about Table and various methods of Inserting and formatting a table in

our document.

1.1 What is a Table?

Table is a method of writing data in rows and columns. It is related to
rectangular or square cells.

Column
H —- Row

Fig 1.1 Construction of a Table

Horizontal lines of the table are called Rows and vertical lines are called
Columns
And intersection of rows and column is called Cell.

1.2 Creating a Table

Word provides a variety of ways to create a table. The simplest way to
create a table is to click on TABLE button in the Tables group on the Insert tab.
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Fig 1.2 Creating a Table
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1.2.1 Using Table Button

\ .

oy

& b J HR i~y | : » -y = B A (= A B signatue Lne -
A LS E me ¥ 19 “ a4 Q 4 N 323 39N 3 4 8 e e nQ
Cover Snh Pege || Table | Pt CHp  Shaped Smadtdn Chad Soeenihol | Hyperlink Bookmark Creicmfamdr  Hesder Fooler  Rage Ted  Quitk Wt O Equstlen Symbol
Fage= Paoe  Deeak At - - - = Muster=  Bexc Parmie < e - Ml Ojedt = - -
Al Table e [ Vienden & Footr teat —

Con o A

e Fage Laveut Referundes MGilinge Prig Viewr

] T W

s

Fig 1.3 Using Table Button

1. Click where we want to insert a Table.
2. Click on the Table button in the Tables group on the Insert tab.

3. Move the mouse pointer over the grid and cover the number of rows
and columns you want in the table.

4. The table will be inserted on the working area (As shown in Fig.1.4).
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Fig 1.4 Inserted Table on Working Area
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1.2.2 Using Insert Table Option
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Fig 1.5 Using Insert Table Option

1. Click on the Table button in the Tables group on the Insert tab .
2. Click on Insert Table option.
3. The Insert Table dialog box appears (As shown in Fig 1.6).
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Fig 1.6 Insert Table Dialog Box
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4. Specify the number of columns and rows in the dialog box and click

on OK. The table will be inserted in our document.

5.  When you insert a table, two new tabs (Design and Layout) also appear
on the Ribbon, displaying various Table Tools (As shown in Fig 1.7). By
using these tabs, we can format design and layout of our table.
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Fig 1.7 Showing Design and Layout Tab
1.2.3 By Draw Table.
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Fig 1.8 Draw Table Option

Working with Tables and Mail Merge in MS-Word

Lo ]

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

2. To define the outer table boundaries, draw a rectangle. Then draw the
column lines and row lines inside the rectangle. Remember that while
doing this process we should not leave the mouse (left) button.In the
end leave the mouse button. To attach a new column , click on the top
right corner of the previous column and then drag to the downwards.
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Fig 1.9 Drawing with the help of pencil
1.3 Entering Data

Place the insertion point in a table cell and type the text. To move to the
next adjoining cell, either press the tab key or press the Right arrow key. To go
back to the previous cell, either press the Shift+Tab key or the Left arrow key.
Try to enter the data as given in the following Table.
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Fig 1.10 Entering Data
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1.4 Modifying a Table

After entering data in a table we can make changes in the data as needed.
We can insert rows, columns or cells in a table to accommodate new text .
Similarly, we can delete unwanted columns or cells from a table.

1.4.1 Inserting Columns in a Table
1.4.1.1 Word provides the facility to add columns to right or left of the

existing column.

1. To add a new column, select the column adjacent to which we want
to insert a new column.

Click on the top border of the column to select it.

Under Rows and Columns Group, on the Layout Tab, do one of the
following;

a. To add a column to the left of the selected Column, click Insert
Left in the Rows and Columns Group.

b. To add a column to the right of the selected Column, click Insert
Right in the Rows and Columns Group.
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Figl.11 Inserting Column(Left or Right)

1.4.1.2 We can also Insert columns by Right-click on the selected cell
adjacent to which we want to insert a new column then click the Insert option.

1. To add a column to the left of the cell, click Insert Columns to the Left.

2. To add a column to the right of the cell, click Insert Columns to the
Right.
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Fig 1.12 Insert columns by Right Clicking

1.4.2 Inserting Rows In a Table

1.4.2.1 Word provides the facility to Insert Rows above or below the
selected row. To add a new Row, select the Row above or below to which we want
to insert a new Row.

1.
2.

Click on the cell of the row to select it.

Under Rows and Columns Group, on the Layout Tab, do one of the
following;

a. To add a Row to the above of the selected cell, click Insert Above
in the Rows and Columns Group.
b. To add a Row to the below of the selected cell, click Insert Below

in the Rows and Columns Group.
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Fig 1.13 Inserting Row (Above or Below)
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1.4.2.2 We can also Insert Row by Right-click on the selected cell above or
below to which we want to insert a new Row then click the Insert option.

1. To add a Row to the above of the cell, click Insert Rows Above.
2. To add a row to the right of the cell, click Insert Rows Below.
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Fig 1.14 Insert Rows by Right Clicking

1.4.3 Insert a cell in a Table

By Right Clicking on a particular cell we can insert a cell in a Table.
1. To Insert a cell, click on Insert Cells option

] Innserl Celis

) shift cells right
& iChift colic dowven!
) Insert entire row
) Insert entire column

(o< ][ conce ]

Fig 1.15 Insert Cell
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2. Select shift cells right or shift cells down option
3. Click Ok Button.

1.4.4 Deleting Columns in a Table

1. Select the column which we want to delete

2. Click on Delete > Delete Columns option in the Rows and Columns
group from layout Tab in Table Tools.
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Fig 1.16 Delete Columns

our column will delete from the selected table.

1.4.4.1 We can also delete columns by Right - Click on the selected
column

1. Right-click on the selected column.
2. Select the Delete Cells option.

3. Select Delete entire column option.
4. Click on Ok button.
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Fig 1.17 Delete Columns By Right Click option
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1.4.5 Deleting Rows in a Table

1. Select the Row which we want to delete

2. Click on Delete >Delete Rows option in the Rows and Columns
group from layout Tab in Tables Tabs.
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Fig 1.18 Delete Rows

1.4.5.1 We can also delete Rows by Right - Click on the selected Row
Right-click on the selected row.

Select the Delete Cells option.

Select Delete entire Rows option.

Click on Ok Button.
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Fig 1.19 Delete Rows By Right Click option
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1.4.6 Deleting Cells in a Table

1. Select the cell which we want to delete
2. Click on Delete>Delete Cells option in the Rows and Columns group.
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Fig 1.20 Delete Cell

1. A dialog box as shown in following figure will appear

| L

Delete Cells @_‘Q

R RS R AR ERER AR ER R R R AR

©) ishift cells left;
() Shift cells up
() Delete entire row

() Delete entire column

| oK Cancel

Fig 1.21 Delete Cells(1)

2. Select shift cells left or shift cells up option
3. Click OK button

1.4.6.1 We can also delete Row by Right -Click on the selected cell. To
which we want to delete then click the Delete Cells>> Shift cells left or Shift
Cells up. Then click on OKk.
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Fig 1.22 Delete cell by Right Click Option

1.4.7 Deleting Table

1. Take a cursor at any place on the Table
2. Click on Delete >>> Delete Table option in the Rows and Columns

group.
wWed9-0l= Document2 [Compatibility Mode] - Microsoft Word
Home Insert Page Layout References Mailings Review View
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Fig 1.23 Delete Table
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1.5 Properties of a Table

In any Table we can align our text left, right, center and justified. We can
align our Table left, right, center. We can also change the size of rows, columns
and cells. All these can be done with the help of Table Properties option. Let us
know how it happens:

(2) (1) /
\ ,
W d9-0o\ Document1 - Microsoft Word | Table Too / |
Home Insert Page Layout References Mailings Review View Design Layout
N =l | ! : e
i [EH ’ e | B e f’ﬂ = B =5 [ |l neort oseem
Select View Properties Delete Insert Insert Insert  Insert srge  Split Spiit AutoFit o7 width:  3.26 em
Gridlines v Above Below Left Right Cells Table v
Table Rows & Columns . Merge Cell Size

Fig 1.24 Properties of a Table

1.5.1 Alignment of Table

1. Place your cursor anywhere in the Table.

2. Click the Layout Tab

3. Click the Properties button in the Table group. The Table Properties
dialog box is displayed.

4. Select the Table Tab.

5. As per your choice select right, left and center

6. Click on OK button

; | ————
Table Properties =B

Tote | fow [ Comn | Coll | AtText

Size

.....................

[Tlipraferred wdth:] 0" = Measwen: |Inches

“ Indent from left:
I 0' 2

| Borders and Shading... | | Dptions... |

-

Fig1.25 Alignment of a Table
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Note : we can also align the table by using the Right Click on the Cell then

by clicking the Table Properties

: fY, Paste Options:
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Split Cells...
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AutoFit
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3% Tranglate

Additional Actions
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Tt w oo

]

22
=

A 5

Fig 1.26 Alignment by Right-Click option

1.5.2 Changing the size of Row, Column or Cell

1. Place the cursor in that row,
column or cell whose size we
want to change.

2. Click the Layout Tab

3. Click the Properties button in
the Table group. The Table
Properties dialog box is dis-
played. (as shown in fig 1.27)

[Tette roperis — O
| Teble |[ Bow ||Comn | col | atText |
Row 5:

Size

[ gpecify height: 0" + Row height is:

Opbons
[¥] Alow row to break across pages
Repeat as header row at the top of each page

(= erevousRow | [ textRow |

o J[ oo ]

Fig 1.27 Changing the size of Row, column or cell
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4. If we want to change the size of selected row then select row tab. It will
tell the size of selected row ,we can approach the other rows with help
of previous row and next row button. No of row will appear on specify
height check button.

5. Click specify height check in order to change the Height of the row.
6. Determine the height of the row.

7. To determine the width of column or cell repeat the step 5 and 6 for
column and cell tab.

8. Click on OK button

Note : We can also change the size of row, column or cell by Right Clicking
on the cell then by clicking the Table Properties.

1.6 Splitting Cells

To divide a cell into many cells, we use the Split Cells option.
1. Select the cell you want to split.
2. Click the Layout tab.
3. Click on Split Cells button in the Merge group. (as shown in fig 1.28)
A

l‘i]:

File Home Insert Page Layout References Mailings Review View Design Layout

N . o m B H 3| B8 j -
¥ ; = — frrry ight; 0.19°
N E D AR =S E e
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v Gridlines ¥ Above Below Left Right Cells | Cells | Table ¥
Table Rows & Columns P Merge Ce

9.0l Document2 [Compatibility Mode] - Microsoft Word i-i’ Table Tools |

Fig1.28 Splitting Cells

4. The Split Cells dialog box appears.
(as shown in fig 1.29)
5. Enter the number of rows and Number of columns: |2

columns into which we want to split Number of rows: |1
the selected cells. Click on OK.

Merge cells before split

Lok [ conel |

Fig 1.29 Splitting Cells(1)
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1.7 Merging Cells

Sometimes, data is split in numerous segments of a cell and we want to
combine it in a single cell, to give it a better look.

1. Select the cells we want to merge. Click the Layout tab.
2. Click on Merge Cells button in the Merge group.
3. The data gets combined in one cell

@I H9-0= Document2 [Compatibility Mode] - Microsoft Word -—-’ Table Tools
Home Insert Page I.a;rout References Maqlmgs Review Vrew Design Layout

NEENEIERE EN S

Select View Properties Delete Insert Insert Insert Insert Merge Split Split = AutoFit

3] Height: 0.19°

Viel ! o Width: 133
*  Gridlines v Above Below Left Right Cells Cells Table v
Table Rows & Columns - Merge Ce

Fig1.30 Merging Cells
1.8 Splitting Table

If our table is too large then it can be divided in more than one table. A
Large table is divided into more than one table by using following steps

Take the cursor to that call where we want to divide the table
Click the Layout tab.

1.

2.
ﬂ' d9 Documentd [Compatibility Mode] - Microsoft Word ﬁ’ Tabie Tools |
Home Insert Page Layout References Mailings Review View Design Layout

s B XS E R e

Select View Properties Delete  Insert Inset Insert Insert Merge Split
Gridlines - Above Below Left Right Cells  Cells

Table Rows & Columns . Merget

== 2l Height: l0.21°

AutoFit {::.Width: 067

Ce

Fig1.31 Splitting Table

3. Click on Split Table button in the Merge group. Rows above the se-
lected Row will be appear in a new table.
Note : Table can be divided only horizontally. If there is only one row in
table and we want to divide it then a line will appear (not row) above.

1.9 Mail Merge

It is often required to send letters with similar information to different
people. The letters require the name and address of each recipient to be printed

Working with Tables and Mail Merge in MS-Word Ill
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on the top. So, changing the address each time would be a very long process and
a big wastage of time and effort.
Mail Merge feature is used to combine a data source with the main document.

1.9.1 Data Source : Data Source consists of mailing list, for example,
name, address, city, pin, telephone number etc. The data is organized in tabular
form along with the field names. The data source is associated with the main
document, so its field names can be used in the main document and it becomes
easy to merge addresses along with the main document.

1.9.2 Main Document : [t contains the text that we wish to send to all the
recipients.

It saves our time and energy to send letters at multiple addresses. First
open the document which you have to send to different people and then perform
the following steps:

1. Click on the Mailing tab.

2. Click on the Start Mail Merge button
3. Click on the Step by Step Mail Merge Wizard

Step 1

Wid9- 0l

Home Insert Page Layout References Mailings Review
= _-II ). | |= .
S J E == . _ﬁ
teP 2 Start Mail| Select
Merge ~ |Recipients - ¢

Create Letters Write &

E-mail Messages
Envelopes...
Labels...

Directory

Normal Word Document

Step by Step Mail Merge Wizard... _ Step 3

Fig 1.32 Mail merge
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4. The Mail Merge task pane appears on the right side of the screen.

5. Since we are going to create letters, select Letters option under the

'Selected Document type' section

Step 5

Send letters to a group of people.

You can personalize the letter
that each person receives.

Click Next to continue.

Step 6

Fig 1.33Mail merge

2

Click on the use the current document.

N

8. Click on Next : select recipients option
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.._._,_._
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Fig 1.34 Mail merge

Step 7
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Note : We can use the existing list by selecting the option "use an existing
list". Here we are creating a new list of recipients.

9.
10.

11.
12.

Click on Type a New list option.

Click on the Create option.

Select recipients
() Use an existing list
() Selact from Outiook contacts
Step 9 @ Type a new list

Type a new list

Type the names and addresses of
redpients

Step 10 2 G

Fig 1.35Mail merge

The New Address List dialog box appears. (as shown in fig 1.35)
Click on the Customize columns button. The Customize Address
List dialog box opens. Add the new columns by clicking on the Add
button. Remove the not required column by clicking on the Delete
button. Click on the OK button when done.

|
New Address Lis 9B
TIype reoplent riformationin the tabie. To add more entries, chek Mew Enry.
Te ¥ w|fshome  v|lofams ] Comen Name v |Addessine | v ||
= - 2
—t 1 Customize Addness List -]
B E*ﬂ J
e Ak, |
‘F‘!‘Nﬂﬂe
Last Mame:
Cempany Name: __%_, |
Address Line 1 — &
Adcress Line 2 _Bename.., | |
foe
|ZP Code |
Catritry or Regeen |
Hame Phone
! ] | |E-mai Address
[deneiy | [ end ]
[ ReteieEntry | | Customize Cobams... | s PORG |
. : ) |
|

Fig 1.36 Mail merge
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13.
14.
15.
16.

17.
18.
19.
20.

In the New Address list box, enter the data in respective fields.

Click on the New Entry button to enter the data in the new record.

By repeating the step 14 enter as many as records as required.

Click on the OK button

1LY

L T e

Type recipient information in the table. To add more entries, dick New Entry.
FrstName v |lastName v |Company Name w | Address Line 1 w | Address Line2 « |
|| Navdeep Singh vadeanLt 553 Industrial a... mohali
ir.— —— = rr—— — T  Sector2d B Il
[l m =
—#{ tewenty | [ Ena I

Fig 1.37Mail merge

The save Address list dialog box opens.
Specify a file name.

Click on the Save button.

The Mail Merge

U — .

Mail Merge Recipients

-

|5

Recipients dia-

This is the list of recipients that will be used in your merge. Use the options below to add to or change your ist. Use the
checkboxes to add or remove redplents from the merge. When your kst is ready, dick OK.

log box opens.
You can see all
the records
here which you
have entered. If

you don't want |||« w J
to send the let- |

|a.mdb 1_21 m.u|
ters to a par- e,
ticular recipi- Fp——

ent, de-select
the check box

-

in front of that
record.

Fig 1.38Mail merge
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21. Click on the OK button.
22. In the Task Pane, click on the Next : Write your letter.

(@) Use an existing list
() Select from Outlook contacts
() Type a new list

Currently, your recipients are
selected from:

[Office Address List] in “jashan.mdb®
] Select a different list...

:"{ Edit redpient list...

Step3of 6
» % Next: Write your letter
¥ Previous: Starting document

|
“dw

Fig 1.39 Mail merge

23. Position the cursor where you want to place the merge field.
24. Click on the Insert Merge Field button.
25. Click on the Field to insert.

-8 - Documentd - Microsoft Word
8 Home Insert Page Layout References | Maifings | Review View
=1 Envelapes . _;:. 3 E g ] Address Block £ 't{
3 Labels ; : — =] Greeting Line s
Start Mail  Seledt Edit Highlight | == Previe
Merge = Recipients~ Reciplent List | Merge Fields | S Insert Merge Fieldi=| 2] Resull
Create Start Mail Merge w Tithe I |
JERE - - - EIEE T BB A First_Name
Last_Name
= =  Momme | Insert Ma
> | Address_Line_1

Address_Line_2
Subject: Submission of Poems forthe “Children sectio City

"l Respectedsir State
IF_Code
I am very fond of writing poems, |am submitt | ., o gegion

poems for your magazine. If you find suitable,

Home_Phone
it in the children section of your magazine

Work_Phone

Email_Address

Fig 1.40 Mail merge
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26. Repeat the steps 23, 24 and 25. Insert all fields at required places.

To

«First_Name»«Last_Namen»
«wCompany_Namen»

«Address_Line_1»

Subject: Submission of Poems for the “Children section”

Respected sir
“ | am very fond of writing poems, | am submitting some
i - Al n:l L . [} L= i AA=_ b

L SECRSRSURE WA ISR SRl SN SO SRS St

Fig 1.41 Mail merge

27. In the Task Pane Click on the Next : Preview your letters.

Step 4 of 6

% Next: Preview your letters
@ Previous: Select recipients

—

Fig 1.42

28. The first record will get display. Click on the Next (| >= |) button to
preview the next record and on the previous ([ << | ) button to

preview the previous record

To
_ 1 Movdecp Singh
Mavdeep Pyt. Ltd,

T, ndusral s

Subject: Submission of Poems for the "Chiliren cection”
" Respectedsir

_1 lam very fond of writing poems, | am submitting some
poems for your magazing, if you find suitable, kindly publish
it in the children section of your magaiine

Ragards
7| ABC

F
feR— e

Fig 1.43 Mail merge
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29. Click on the Next:Complete the Merge option.Now the mail merge is
ready to produce your letters. You can either print the merged letters
on the printer or edit each letter individually, to add some personal
comments or a picture etc.

30. Click on the Edit individual letters option.

1 Mail Merge v X

Complete the merge

Mail Merge is ready to produce
your letters,

To personalize your letters, dick
"Edit Individual Letters. " This will
open a new document with your
merged letters, To make changes
to all the letters, switch back to
the original document.

Merge
523 Print...

L » ] Editindividual letters...

Fig 1.44 Mail merge
31. The Merge to New Document dialog box opens.
32. Click on "All" option.
33. Click on the OK button.

Fig 1.45
A new document will get created containing all the merged letters.
This new document is known as merged document.

Iil Computer Science
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Points to Remember
® The intersection of column and row is called a cell.
@® Table Styles is an inbuilt facility to change the appearance ,colour and
borders of a table.
® Dividing a cell into multiple cells is called Splitting.
® Combining two or more cells into a single cell is called Merging.
® Mail merge feature combine two document, one is main document and

the other is Data Source which is associated with the main document

F_E.'fxg@mn:iﬁgﬁ@ﬂ

Fill in the blanks

1. key is used to move the cursor in the adjoining cell of a table.
(@) Ctrl (b) Shift
() Tab (d) Home

2. The table button is present on the tab.
(a) Home (b) Layout
(c) Insert (b) View

3. We can change the width of a column by selecting the button
in the Table Group.
(@  Select (b) View Gridlines,
(c) Properties (d) None of these

4. contains the text that we send to all the recipients.
(a) Data Source (b) Merged Document,
(c) All of these (d) None of these

5. consists of mailing list.
(@) Data Source (b) Merged Document,
(c) All of these (d) None of these)

Working with Tables and Mail Merge in MS-Word Iil
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True/False
1. Press Shift+Tab key to move to the next cell.
2. The intersection of a column and row is called a cell.
3. Data source contains the text that we wish to send to all the recipients.
4. Split cells option is present on the Table group.
5. Cells cannot be merged in a table.
Short Answer Type Questions:
1. Name the one method by which you can insert a table in a document.
What is the use of Split Cells option?
Name the option by which you can change the column width?
What is the use of Merged Cells option?

What is a data source?

I

What is a Main Document?
Long Answer Type Questions:

1. What do you understand by the term Mail Merge? Write steps to
perform Mail-merge.

How do you insert a table in your document? Explain any one method.

Explain the process of Alignment of a Table.

Iil Computer Science

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

Internet Fundamentals

OBJECTIVES OF THIS CHAPTER :

2.1 What is Internet?
2.1.1 History of Internet
2.2 Requirements for Internet
2.2.1 Hardware Requirements
2.2.2 Software Requirements
2.3 Task performed by Network and Internet
2.4 Internet Connections
2.4.1 Types of Internet Connections
2.5 Modem
2.5.1 Types of Modem
2.5.2 Speed of Modem
2.6 Internet Service providers(ISP)
2.7 Benefits or services provided by Internet
2.7.1 World Wide Web
2.7.2 Electronic Mail
2.7.3 E-commerce
2.7.4 Social Networking Sites
2.7.5 Video conferencing
2.7.6 Chatting
2.7.7 Websites Searching
2.8 Software skills
2.8.1 Internet skills
2.9 Web Browsing.
Internet Fundamentals Iil

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

INTRODUCTION

Today the use of internet has increased tremendously. It has revolution-
ized the whole world and made computers the most effective communication
tool. Internet gives us access to information on almost every subject. In this
chapter we will learn about what is Internet and how it came in to existence.
Also we will discuss some of the services and tools which are commonly used
to access the Internet, and will learn about how to begin searching the Internet
for information. A specific technology which is rapidly becoming one of the
central mechanisms for providing information on the Internet, the World Wide
Web, will also be explained in it.

2.1 What is Internet?

Internet is one of the best technologies gifted to mankind in the present
scenario. It has brought the entire world at our fingertips.

The name 'Internet’ itself suggests its meaning. It stands for International
Network of computers. A network is an interconnection between two or more
computers. The Internet is a "network of networks" that consists of millions of
computers spread across the world. Internet allows us to share the information
worldwide, with just a mouse click.

Figure 2.1 internet

Iil Computer Science
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2.1.1 History of Internet

In 1969 when man walked on the moon; the U.S. defence department set
an Advanced Research project Agency(ARPA) for further research. They designed
a network of four computers to exchange and share their data. This network
was called ARPANET (Advanced Research Project Agency Network). Later, many
universities were allowed to join this network and share the information. This
was the beginning of 'Networking of computers' which grew bigger day by day
and gave birth to INTERNET- the technology which has changed our life. Ear-
lier, Internet was used by engineers, scientists and computer experts for re-
search purpose. Gradually, the network was made accessible to private agencies
and general public. People started using it for sending messages and files be-
tween the computers. The most interesting thing about Internet is that no single
agency controls or maintains the Internet.

In India, internet services started on 15th August 1995 through gov-
ernment owned VSNL. Now many private internet service providers like
Airtel, Reliance, Sify, Tata etc. have also been allowed to provide internet
services

2.2 Requirements for Internet

Use of Internet needs following things

2.2.1 Hardware Requirements:

® A personal computer with a speed of 800 MHz or more
RAM of about 128 MB

Telephone line connection

Modem to link Internet
® TCP/IP protocols(rule)

2.2.2 Software Requirements

® Windows XP, Windows 7, Windows 8, Linux etc any operating system

® Internet Explorer, Netscape Navigator or any other web browser

2.3 Tasks performed by Internet and Network:

Network is a group of two or more computers linked together. If two or
more networks are joined together then they form inter-network. Internet is a

Internet Fundamentals Iil
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inter-network of whole world. Thousands of networks are joined with internet.

We can perform many tasks with Internet as described below

E ' E - ju /g 0
- O — éﬂq b = !_..! i_!_
18-—O -1 ]
ju
i | 5.
\ L L L ]
= -t = - ol e L HNT

Network Infernet

Fig 2.2 Network & Internet

® NEWS AND INFORMATION: Internet provides facility to read different

newspapers online and get the information regarding various topics of
our interest such as politics, sports, education etc. It also keeps us
updated with current events.

ART AND ENTERTAINMENT: Internet allows us to download and
purchase various software for art and entertainment such as games,
songs, movies, jokes, stories etc.

ON-LINE SHOPPING : We can purchase various items like books,
clothes, gift items etc. from different e-shops around the world with-
out actually going there.

MAILING LETTERS : Electronic mail is the most popular feature of
the Internet. It allows us to send and receive messages. We can also
attach pictures, videos, sounds to our email and send it to anyone.
HEALTH AND FITNESS : we can have an all time doctor at our
service to provide health and fitness information. We can also search
for remedies and precautions for different diseases.

TOURISM AND TRAVEL : Internet provides facility for online booking
of hotels, railway tickets, air tickets etc. all over the world and round
the clock.

| 30 |
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® CHATTING: Internet allows us to exchange text messages with an-
other person anywhere in the world.

® BANKING OPERATIONS: Now all Banking operations can be done
right from our home using Internet / e-banking services.

® VIDEO CONFERENCING: Through video conferencing, we can com-
municate with the other person visually. To do video conferencing,
both the persons need to have web cameras.

2.4 INTERNET CONNECTIONS

In today's age, there are numerous ways to connect laptops, desktops,
mobile phones and tablets to the Internet. When determining which type of
Internet connection is right for us, it's important to understand the distinction
between each connection. Some of the most widely used Internet connections
are listed below.

2.4.1 TYPES OF INTERNET CONNECTION

Any one of the following basic connections can be used for internet.
Dial-up Connection

Broadband

Wireless

DSL (Digital Subscriber Line)

ISDN (Integrated Services Digital Network)

Broadband connection joins computer to the lines of telephone or trans-
mission institute. It is always used with high speed. Maximum Business cen-
ters, Universities etc. have a permanent internet connection. Small business-
men or personal users have personal TV lines of DSL (Digital subscriber line) for

permanent connection. This facility is costlier than dialup connection. Through
dial up connections can be established with telephone line or cellular device.
This connection is used by the users who use internet occasionally.

2.5 Modem

Full Form of MODEM is modulator-demodulator. A modem is a device or
program that enables a computer to transmit data over telephone or cable lines.
Computer information is stored digitally, whereas information transmitted over
telephone lines is transmitted in the form of analog waves. A modem converts
between these two forms i.e by converting the digital data used by your com-

Internet Fundamentals Iil
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puter into an analog signal used on phone lines and then converting it back
once received on the other end.

Fig 2.3 Modem

2.5.1 Types of Modem

Modem is of two types : External and Internal

2.5.1.1 External modem is linked to computer externally with cables.

Fig 2.4 External Modem

2.5.1.2 Internal modems are fitted inside the computer. Cable or tele-
phone wire goes to modem through plug.

Iil Computer Science
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Fig 2.5 Internal Modem

2.5.2 SPEED OF MODEM

Speed of modem is variable. Slow modem takes more time to send or
receive message. It takes more time to copy files from Internet if both the
computers of transmission have different speeds of modem then transmission
will be according to the slow speed modem. So use only fast speed modem.
Generally a modem with 28.8kbps speed is used. Surfing needs modem speed
not less than 56 kbps.

2.6 INTERNET SERVICE PROVIDERS(ISP)

Internet Service Provider(ISP), it refers to a company that provides
Internet services, . For a monthly rent, the service provider usually provides a
software package, username, password and access phone number for eg Airtel,
Vodafone, BSNL. For broadband access you typically receive the broadband
modem hardware or pay a monthly rent for this equipment that is added to your
ISP account billing. Equipped with a modem, you can then log on to the Internet
and browse the World Wide Web and send and receive e-mails.

In addition to serving individuals, ISPs also serve large companies, provid-
ing a direct connection from the company's networks to the Internet. ISPs
themselves are connected to one another through Network Access Points (NAPs).

Internet Fundamentals Iil
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ISPs may also be called IAPs (Internet Access Providers).

Internet Service Provider

Fig 2.6 Internet Service Provider

2.7 BENEFITS OR SERVICES PROVIDED BY INTERNET

In today's technological world, there are plenty of services that are pro-
vided by the Internet. The list contains email, which enables us to keep in
contact with friends, family, and employers. There are also search engines that
allow us to search for information that is provided by professionals and indi-
viduals alike. Other services include sites like facebook and My Space that allow
us to interact socially with people from all over the world. Most businesses today
are connected to the Internet so we can also pay bills, do banking, and shop
online. Some of the main services are described below.

2.7.1World Wide Web

The World Wide Web (WWW) and the Internet function together but are
not the same thing. The World Wide Web is a large computer network
where by using a browser such as Internet Explorer, we can surf and get
information. It consists of all the public web sites connected to the Internet
worldwide, including the client devices( such as computers and cell phones)
that access web contents. The websites are identified by short, unique,
global identifiers called URLs (Uniform Resource Locator). World Wide
Web is also called website or site. It contains e-mail, newsgroup, mailing
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list and sent files. We can get information through web. Website is formed
by one of more pages. It contains facilities regarding to business, educa-
tional institutes, research facilities and for personal interest.

2.7.2 Electronic Mail

It is also called e-mail. You can send a desired message with the help of
e-mail. Text, video, voice and other files can be sent through it.

2.7.2.1 Benefits of E-mail : E-mail has following benifits :

1 Cost : Cost given for use of internet is the only money given. User
need not to give money for postal stamps. It is cheaper than fax. The
e-mail does not need such costs. Cost of long massages is equal to
that of short message. Also cost of sending message overseas i.e. to
like that of paper, telephone charges etc. Very for off distances is
same as that for sending to your own city.

2 Speed : Its speed is greater than postal transmission e-mail message
can reach its destination within no time. We can correspond any
times in a day.

3 Convenience : Computer user can type the message in his computer
and send e-mail at any time of his convenience. It saves paper, postal
cost and any other problem.

More commonly known as email, electronic mail started as an afterthought
to the Internet. Today, email holds the number one position as the most popular
service offered on the Internet. A protocol for sending, receiving and storing
electronic messages, email has become the preferred method of communication.
The U.S. Postal Service handles around 200 billion pieces of mail each year.
Email service on the Internet handles around 247 billion emails every day.

Fig 2.7 E-Mail
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2.7.3 E-Commerce

The ability to do business without the usual constraints of time or dis-
tance make e-commerce one of the most important services provided by the
Internet. With the single click of a mouse, online customers can purchase
almost anything day or night from the comfort of their own home.

CUSTOMERS

BANK PAYMENT

SHIPPING
\ / F/LM |

Fig 2.8 E-Comunerce

2.7.4 Social Networking Sites

The Social networking websites function like an online community of
internet users. In social Networking websites, every user has a profile, which
contains information about them. A user can also invite other people to join
these websites, no matter what their hobbies, beliefs or interest are. Some of the
popular social networking sites are: Facebook, Orkut, Twitter etc.

Fig 2.9 Social Networking Sites
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2.7.5 Video Conferencing

It involves the use of video cameras connected to two or more computers.
Images and sounds are then sent through the Internet where users not only
hear each other but can also have a face to face conversation.

Fig 2.10 Video Conferencing

2.7.6 Chatting

A chat is an online conversation over the Internet in which we can in-
stantly send text based messages back and forth to one another. There are
various types of chats available on the Internet. Chatting means - word talk. It
is similar to telephone conversation. Difference is only that in chatting only
words are used. If you are linked through internet then you will type in com-
puter or mobile Instead of speaking in telephone. Voice chatting is also possible
now. In voice chat you can speak and listen.

2.7.7 Websites Search
Number of pages is not fixed on website. These are unlimited. These go on
increasing. Big companies save their web pages in this data base.

Search engine is used to find information. It is a powerful program.
Desired information can be found by typing it. It will show a list of many such
websites related to that word.

2.7.7.1 Methods of searching

Let us learn about fundamentals of searching. First of all type a few a
words in the text box of search engine. In advance search you have to set word
match, complete phrase match or insert key-word match.

Internet Fundamentals Iil
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Following things should be kept in mind while searching in a right way :
® Use (+) sign for that word which should be present in search result.
® Use (-) sign for the word which should not be present in search result
® Use coat marks (' .)to show phrase

From the example given in following from, it is clear that you are finding
cookie recipe site. The words written in text tells that this site is of North India
and it contain rice.

Fle Edt Vew Faorits Took Heb
Quc O WG Pt rroom @ 30 5 B9 3

ADTESS ]]rtrp:/Jm.gngb.cu.n/sea_rmmlqﬁqqod(emanemwmmmh%_zdﬁm_a= _ v Ga

Googler cge-iosnrth rgan @ G Serch * § Bosboded % ches + A Adirk + Ropts & » ot

Web Images Groups News more »

Google _tndqre«eclpbncmm indian Advanced Search

Preferences

Search: © the web Opages fom India
Web Results 1- 10 of about 702 for cookietrecipe-ricetnorth indian. (0.50 secon

North Indian Recipes - East - Indian Recipes - South Indian ...

w Finance. India. Industry. Intemet. Jobs. .. Home. Search. Contrbutions. Indian Recipes.

Welcome to the Links2India the complete collection of delicious Indian Recipes ...
www.indianwebdiractory comirecipes php?gid=5 - 39k - Supplemental Result - Cached - Similar pages

Indian Recipes : Vegetarian Recipes from India

.. Options: Remove Cookies, Remove Scripts, Remove Ads, Text Only, Keep ... Vegetarian Recipe :

Rice with Dried Mushrooms, Kanegach Puiav, North Indian Kashmir. .

hitps /Avebproxy kaxy.com/b/ aHR0c DovL3d3dy5ze XZ 1bS5jb20vemVjaXBleyIpdn)pbmRIleC5odGl s - 70k -

Qunnlamantal Racult . Marhed . Qimilar nanae

Fig 2.11 Web Searching
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2.8 Software Tools:

We should have complete knowledge of computer in order to take full
advantage of internet. Some ISP softwares are also provided. Different tools are
used for different purposes. This tool depends on your requirement. It include
following tools:

® E-mail program

® Browser

® News Reader

® FTP software

2.8.1 Internet Skills

Although softwares of internet has been greatly improved yet the internet
user need skill of using it. User should know how to start, or close a program
and copy a file. He should know something more than menu, icon, print, type
and editing. Knowledge of all these things is called basic computer skills for
using Internet.

2.9 Web Browsing

World Wide Web is an important facility of Internet. To Browse the infor-
mation , we can take the help of any search engine such as Google, Bing etc.
We can view required information with them.

- O 7 v googe cor . A

Google

Fig 2.12 Web Browsing
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&

Points to Remember

Internet is a 'metwork of networks' that consists of millions of com-
puters spreadsheet across the world.

E-mail is a facility on Internet to send and receive messages to any
part of the world.

Internet explorer is one of the most popular and widely used web
browser developed by Microsoft.

Each Web page has a unique address called Uniform Resource Loca-
tor.

The World Wide Web is a collection of pages stored on the Internet.

FEX&@U«U:E@@‘.H

1. Fill in the blanks:

1.

International Networks of Computer is known as

(@) ARPANET (b) INTERNET
(0 INTERANET (d) ETHERNET
www stands for .
(a) World Wide Web (b) World Web Wide
(c) Wide World Web (d) Web World Wide
A is an online conversation over the Internet.
(a) E-commerce (b) Chatting
(c) WWW (d) None of these
is the fastest way of sending mails.
(a) Telegram (b) Letters
(c)I ISP (d) E-mail
is a device that connects a computer with telephone line.
(a) Modem (b) Telephone Wire
() Mouse (d) Mobile

Iil
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2. True/False

1.

s N

A webpage is a collection of websites.

Internet Explorer is the name of an ISP.

Facebook is one of the popular Social Networking Website.
Internet computers communicate through network

The software that allows you to explore information on the web is
called web site.

3. Short Answer Type Questions:

1.

NO ok eDd

8.

What is Internet?

Give some example of Internet Service providers.
What do you mean by the term E-commerce?
Define the term WWW.

Describe the types of Internet Connections.

Tell about E-mail

What is web searching?

List the Hardware requirements for Internet.

4. Long Answer Type Questions

1. What is MODEM ? Also Explain its type and speed.

2. Explain the tasks performed by network and Internet.

3. What are the main services provided by Internet? Explain briefly.

1. Make a group of 5 to 8 students. Go to the lab and find out different
components being used for internet.

2. Search for any topic like car, mobile, computer, motorcycle etc. using
internet

3. a) Click on www.google.com
b) Search for "fonts of Punjabi"
c) click on the appropriate link and copy fonts in your system

Note the result.
Internet Fundamentals Iil

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

Introduction to
Information Technology

OBJECTIVES OF THIS CHAPTER :

3.1 What is Information Technology
3.1.1 Need of Information Technology
3.2 Web Sites
3.3 Searching
3.4 Web Surfing
3.5 Difference Between On-Line and Off-Line
3.6 Downloading
3.7 Net Banking
3.8 On-Line Shopping
3.9 How to View On-Line Result
3.10 Mobile Technology

INTRODUCTION

Now-a-days many companies are in this field of Information Technology.
These companies are earning a lot because of good standards and their creative
and competitive marketing policies. This is only possible if proper information is
received at a proper time and these companies are working on basis of
informations in these days. It is known as era of information technology.

Information technology is related to computer hardware and software.
That technology which is used for processing, storing and exchange of information
is called information technology. Information technology plays an important
role in the progress of a country, towards development. It is changing the life
style, learning, playing and working styles of people.

We are introducing new social programs, scientific discoveries and business
devices due to development of computer information technology. New tools of
communication to collect knowledge and information are being framed.

Iil Computer Science
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3.1 What is information Technology?

It includes all the technologies used to store changes or use information
about business data, voices, discussions, photographs, movies, multimedia
presentation etc.

Information technology is an advantageous field which includes both
telephone and computer technology.

3.1.1 Need of Information Technology:

In our daily life all bills and payments of most of the Govt. and private
firms are printed with the help of computer. ATM facility of banks is also very
useful but it is possible only due to proper use of computer.

Information technology is used to perform many tasks as mentioned
below :

3.1.1.1 For Business and Industry : Information technology is used in
business and industry for following purposes :

® Office Automation : Information technology helps to perform
routine office work  and to increase productivity.

® Management Information System : Information technology
helps the manager to take quick decision.

3.1.1.2 At home : Information technology is used to perform following
task at home :

® Communication : Instead of sending letters, we communicate
with email and chatting.

® Education : Student use internet for their study. There are
various type of education software.

® Entertainment : The older means of entertainment are replaced
by computer and internet. Traditional tapes and cassetts have
been replaced by audio-video CD's.

3.1.1.3 For Training :In Schools information and technology is used to
gain knowledge easily and effectively. Effective multimedia
presentation material is greatly helpful to gain knowledge.
Information technology is also helpful in science and medicine.

Working with Tables and Mail Merge in MS-Word Iil
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3.2 Web Sites

A collection of one or more web pages grouped under the same domain
name is called Web Site.

The pages of a website can usually be accessed from a simple Uniform
Resource Locator (URL) called the web address. Each website has its own unique
web address which can be reached through an internet. The opening page of a
website is usually called homepage which contains hyperlinks to other pages on
the same or other site(s) A company or an individual tells us how to get to their
Web site by giving us the address of their home page. From the home page, we
can go to all the other pages on their site. For example unique web address of
Punjab School Education Board is www.pseb.ac.in.

& & O [ wewpsbacn
//‘ S%5% Punjab School Education Board
STreYE . e
:"."M;: U s "Has = P
Uy -

e e

Fig 3.1 Web Site

3.3 Searching:

Search means : " Try to find out"

Web search is the act of looking for webpages. The system that collects
similar webpages together at one place is called a web search engine.

When we ask a web search engine such as Google or Bing find webpages
related to a topic, we will get back a list of hyperlinks to related webpages. This
list may have a hundred or more links. They are often divided up into a number
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of search engine results pages (SERPs). From a SERP, we decide which link we
should try and see if its referenced page had what we're looking for.

& & sveincnin Tl r ! % FAE - 28 - B N

Fig 3.2 Searching

3.4 Web surfing

Web surfing means to move from place to place (one website to another
website) on the Internet , searching for topics of interest. The term also has
another meaning -- spending time on the Internet.

Web surfing has become a favourite pastime for many Internet users. Just
as in "TV channel surfing," where one clicks the remote to go from channel to
channel, the hyperlinks on Web pages make it easy to go from one page to
another.

3.5 Difference between Online and Offline

The terms "online" and "offline" (also styled as "on-line" and "off-line")
have specific meanings in regard to computer technology and
telecommunications. The general definition of "online" simply indicates a state
of connectivity, while "offline" indicates a disconnected state. Working online
means that we are working on files and/or programs that open from external
source, like a server or website. Working offline means that we are working on
something on our computer.

Working with Tables and Mail Merge in MS-Word Iil
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Fig 3.3 Online and Offline

Online = connected / having access to a network or Internet
Offline

not connected / not having access to a network or Internet

3.6 Downloading

Downloading means our computer is receiving data from the Internet.

Every time we use the Internet, we download data. For example, each time
we visit a webpage, our computer must download the HTML, CSS (cascading
style sheet), images, and any other relevant data in order to display the page in
our web browser. When you click a "Download Now" link, our browser will start
downloading a specific file that you can open.

Examples of downloading include opening a web page, receiving email,
purchasing music files and watching online videos.

Fig 3.4 Downloading
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3.7 Net Banking

A system of banking in which customers can view their account details,
pay bills, and transfer money by means of the Internet is known as net
banking.

Internet banking, sometimes called online banking. Internet banking
uses the Internet to conduct banking activity, for example, transferring funds,
paying bills, viewing checking and savings account balances etc. Internet
banks are also known as virtual, cyber, net, interactive, or web banks. Following
figure shows the login for SBI Account Holder.

i ©E 3%
State Bank of India

The Banker to Every Indian

Home Producis & Services How Do |
Loagin Welcome 10 Personal Banking

To access your accounts. ..

Login to OnlineSBI

(CARE: Username and password are case sensitive.)
Username ' |

Paseward '

| Enable Virtual Keyboard

For better security use the Online Virtual Keyboard to login. More

Fig 3.5 Net Banking

3.8 On line shopping

Online shopping or online retailing is a form of electronic commerce which
allows consumers to directly buy goods or services from a seller over the Internet
using a web browser.

We can search for and purchase products from almost anywhere if the
vendor makes his products available through the Internet. We can pay the bill
of our purchases by using a credit card. Some vendors may allow us to make
our payment by electronically transferring the money from our bank.
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Fig 3.6 online Shopping

The good thing is that purchasing things online is very easy. The advantage
for online shopping is we can start at home and the item comes to. Do we have
plenty of time to go to the store and look up and down for the item like? Most
people say NO, time is precious. So on line shopping is considered as a time
saving activity.

QRO CE b Taplop . ey

w ALL CATEGONIE §

v COMPTERS 4 Top Matching Categones for "laptop”
Lagpteg 4
Lapben it | Cwank -
Lagics Baga
Weaafen - -.o.rl " hpiem s b o Bigy llh.n Py

. i :

. GEE 4

-

EARNH 450 0 : ~

Loming A Foomiana Tapn b il . . w1l

w A WALLLTS & DCLYS

Laiten Bage

& PEND 8 JTATIONENY <
B e et
Tongeer hsrtantam
Ragelw Duenm

Pamy # hasmat iy

Haniafed ‘Clelicn

Fig 3.7 Online Shopping Website
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3.9 How to view On-Line -Result?

In earlier days we have to wait for the gadgets (Manual document of result
published by board or universities) to see the board or university results

But with the help of Information Technology we can view the results
online. For example if we want to see the 10th class result of Punjab school
education board then we will do the following steps

® Open the web browser Internet Explorer or Mozilla Firefox (whatever
is installed in our system)

® On the address bar type web address eg. www.pseb.ac.in & Press
Enter ket

® Click on Result Option.

J @ pstn|Resuts

€& 4 v pesbacinirsuits

m Punjab School Education Board

Y& .‘io - s — WELFLNE
WY UFTT S frfuanr o= S0 e A

_:-{‘d Vidyu Bivewan, Piane 8. Sunitss0s Af1 Singh Nugsr (Mohet) P Code- 160082

% f=3tht
OGN 1e™
e RIS frfenar

ETCTIIERIS )y ooty o venr 2015 G0 - Geptemserg €E® - it of Gelected Candicatss - Press Noss Regarding Online Ssak Demand Somy S - B
Important Links Matriculation Examination RBSURS  Sanicr Soron sy Frarmaanan §asus Latest News
+ Foams L AS Nat Lt 3 AT T e S 6" Schone
Matreutsin= Bt Aditoesl Subjest Exammassn Besut 2014 Ay e e Comract fxses, P
+ Frass HotesSiculan
GOLDEM CHANCE 2004
*  Data Shasl & o v 215 P
Wairicadatios Gotten Enance Exbmbacion Raout 2914 B
+ Senuiaesip —
WARCH 2014

Fig 3.8 Viewing online result

® Click on Matriculation Examination Result.
® Select the year of examination.

® Enter Roll number or name.
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Home : Punjab ' Punjab School Education Board

Punjab School Education Board

Matriculation Examination Result March 2014

To get your results on SMS type PB10 <Roll No> & send to 5676750
e.g. PB10 1014500001 send to 5676750

Enter Roll No

OR

@® Click on Find Result.

Fig 3.9 Viewing online Result

Then result will be displayed on our screen. Also we can take the print of
our result .

3.10 Mobile technology

Mobile technology is exactly what the name implies - technology that is
portable.

Fig 3.10 mobile Technology

Mobile technology is rapidly changing the face of communication in the
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most remote areas of the world. Today, out of the seven billion people in the
world, approximately six billion are cell phone subscribers. In response,
companies, governments, and NGOS alike have realized the potential of this tool
in addressing today's most pressing global challenges. Here are some important
uses of Mobile Technology.

1. Education

2. Surveys and Polling
3. Banking

4. Data Analysis

Points to Remember

® Web site is a collection of one or more web pages grouped under the
same domain name.

® Web search is the act of looking for webpages.

® A system of banking in which customers can view their account de-
tails, pay bills, and transfer money by means of the Internet is known
as net banking.

® Downloading means our computer is receiving data from the Internet.

"Online" simply indicates a state of connectivity, while "Offline" indi-
cates a discc /i

) < CI CISE!S

1. Fill in the blanks:

1. means our computer is receiving data from the Internet.
(a) Uploading (b) Downloading
() Surfing (d) None of these
2. The opening page of a website is usually called
(a) Home Page (b) Web Page
Working with Tables and Mail Merge in MS-Word Iil
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() Main Page (d) None of these
indicates a state of connectivity.

(a) Offline (b) Online

(c) Inline (d) All of these

means to move from one website to another website on the
Internet .

(a) Searching (b) Downloading
(c) Surfing (d) All of these

is a form of electronic commerce which allows consumers
to directly buy goods from a seller over the Internet .

(a) Modem (b) E-Mail
() E-Commerce (d) Mobile

2. True/False

1.
2.

3.
4.
5.

The result of any board or university can be seen online.

We can do Web surfing even when we are offline (not connected with
the Internet).

A website has only a single page i.e. called web page.
Web search is the act of looking for webpages.

Each website has its own unique website address.

3. Short Answer type Questions

1.

2

7.

What is Information Technology?

What is Web site?

What is the meaning of Mobile Technology?
What is the advantage of on-line shopping?
What do you mean by Downloading?

What is Net Banking?

What is Web Surfing?

4. Long Answer Type Questions

s w0 N

Explain the process of viewing on line result.
What is the difference between surfing and searching?
What is difference between Online & Offline?

Explain the Need of Information Technology?

| 52 |
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Introduction to
Power Point

OBJECTIVES OF THIS CHAPTER :

4.1 Introduction to power point
4.1.1 Slide and Presentation
4.1.2 How to start power point
4.1.3 Save Presentation
4.1.4 Open existing Presentation
4.1.5 Parts of PowerPoint Window
4.1.6 How to make presentation

4.2 Inserting New Slide

4.3 Use of Layout and Autoshapes
4.3.1 Layout
4.3.2 Clip Art and Smart Art

4.4 Views of Power Point

4.5 Animation scheme, Transition

4.6 Exiting PowerPoint

4.1 Introduction to Powerpoint :

Powerpoint is an application software used to make effective presentation.
There are many presentation software available in market e.g: Microsoft
PowerPoint, OpenOffice.org Impress (open source),SlideRocket. We will discuss
Microsoft PowerPoint in this chapter. It is a presentation software developed by
Microsoft company. This presentation software uses slides to convey informa-
tion rich in multimedia.

PowerPoint was first developed by Dennis Austin and Thomas Rudkin at
Forethought Inc(sotware company). Firstly it was named Presenter and was
renamed as PowerPoint in 1987.

Introduction to Power Point Iil
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4.1.1 Slide and Presentation

4.1.1.1

4.1.1.2

4.1.2

Slide : As film is made of many incidents the same way
presentation is made of many slides.A slide is a single page of
a presentation. It is just like 35mm film based slide. Slide may
consist of text,graphic,Audio/video

Presentation : A presentation is composed of several slides.
The aim of presentation is to make subject matter easy to
understand by inserting pictures,text, graphs,charts,animation.
The best presentations use approximately ten to twelves slides
.We can insert animation effects audio and video clips in our
slides to make our presentation effective.

Starting power point:

There are three ways to start powerpoint:
1. Through start button

2. Through search box

3. Through shortcut on desktop

1. Through start button:

Start->All Programs->Microsoft Office->Microsoft Office

Powerpoint

L Games

L MeAdee
L Mcilee Securty Scan Plus
L Micresoft Offize

Q5P
Manzenanct

LE} Microsafe Acces: 2011
[&] Micrasafe brel 1018
(X Microsaft InfoPath Designer 2610

(T) Miereeste Infedsth Filar 2010

[N} Microssf OnaNote 2610 g
O] Microsaft Outlosk 2010

‘_HT‘ Miera cnfe Pasasioint 2010 [.}

(B Microssfe Publigner 2010

3. Micrasaft SharePoint Workspace 200
W] Microsut Word 2010 SERI
L Microsofs Office 2010 Tools

Help and tuppcnt

Fig 4.1(i) showing steps to open powerpoint through start button
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2. Through Search Box
i) Click on Search box
ii) Type powerpoint or Power in Search box

iiij Press enter key from keyboard

powerpoint X

Fig 4.1(ii) showing search box

3. Through shortcut on desktop:

If there is powerpoint shortcut on desktop then double
click on the shortcut and the power point will open.

Fig:4.2 Steps for opening power point through icon on desktop

4.1.3 Save Presentation

Presentation is saved so that we can use it in future.There are many ways
to save the presentation

Introduction to Power Point Iil
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1. Through File menu
or

2.  On Quick Access Toolbar, By Clicking Save Button.
or
3. Press Ctrl + S to save presentation.
Save presentation through File menu :-
Click the File menu
Click Save and the save As dialog box will appear .

1
2
3. From Save in pull downlist select the desired location to save
4. In the File name box, enter a new name for the presentation.
5

In the Save as type list, select the file format that we want, and then

click Save.
2. Save button on Quick Access toolbar.
Rld9-0]:
. . File Home Insert
1. Save option on File menu. -

{ [ save
& saveas
(& Open

Fig:4.3 steps to save power point presentation

4.1.4 Open Existing Presentation
We can open the saved presentation by using the following steps :
1. Click the File menu
Click Open and open dialog box will appear.
3. Select the desired presentation and click open
Or
Press Ctrl +O from Keyboard
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o 173 Ooen - -
i save (@8 ENT T T ) PR "
R .
Bl save as Crganoe v Mew foider By (3 @
B2 Open B mcson amce ey Documents library . &
& Open ] e Amngeby Felisr
Cd Close W Twone ‘ = - Dot reaPed Type
I Oebicp |
Infa 1 Oouriond b sonpae Kikeei DO TN Fg folder
54 Rocent Places b Conl Userfides WA/ PSP Ple foder
o Lerh 23 My Data S WT/2006 1000 PM  File foler
Recent ot ) pat nd cutput devices V1ML Mttt
B 4 libases
New & pn
A B
o Mk
- Pichures
.m - ok - J *
ke rame * [ AtPowedont Presstauens -
T (cmn ] |

Fig:4.4 steps to open power point presentation through file menu

4.1.5 Parts of PowerPoint Window

Power Point window containsFile menu, Menu bar tab, Ribbons,Slide Pane,
Note pane, Status Bar, Slide tab

Pragram-lovel

Quick Access Toolbar (QAT) I | it oar_|

Click to add title

Click to add subtitle

Fig:4.5 Showing Parts of power point Window
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1. File menu : This menu is located at the left of home tab.It contains
commands such as New, save, Save as, open, print, save & send, help,

exit etc.
o

e save
Save As
L7 Open

4 Close

e -

Recent

New

Print

Save & Send

Help

21 Options
Exit

Fig 4.6 showing file menu

2. Quick Access Toolbar : it is located on the upper side of file menu .
It mainly contain three buttons save as,undo,redo. We can customize
this toolabar and can add any button that we require frequently to
have an easy and faster access.

3. Menu Bar tab : Each menu bar tab is task oriented and opens the
ribbon that is divided into subtasks

e
File Home Insert Design Transitions Animations Slide Show Review View PDF

Fig 4.7 showing menu bar tab
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4. Ribbons :- When we click on any tab then ribbon shows the tab tools
and commands present on that ribbon.
RIld - 05 Presentation! - Microsoft PowerPoint
IE Hom Insert Design Transitions Animations Slide Show Review View
3 4 ;llayout v > = - - - = g b=
_] J & A A - EE.
3 _EJReset
Paste New B 7 U 8 abe N- Ay EEIE H S
- Slide = - Section~ M
Clipboard Slides Paragrap
Fig 4.8 showing ribbon of Home menu
Ribbon Working
Home It contains all features of clip board, slide, font,
paragraph, drawing and editing options
Insert It contains inserting table, textbox, clipart, smart art,
symbols, insert videos, charts, photo album, etc
Design It contains change page layout, slide themes, colors,
background styles and graphics
Transition It contains all features of transition of slide, timing,
sound effects
Animation Animation,advanced animation and Timing
Slide Show Slide show for entire presentation, rehearse timings,
monitor setting for slide show
Review Proofing techniques,comments, language and compare
View Presentation views, master view, ruler, gridlines and
guides, zoom, color, window and macro

NOTE : When we write any text then a new tab named "format" is shown
which contains clipboard, slides, font, paragraph, drawing and editing op-
tions.

5.
6.

Slide pane : it is the area in which slide can be created and edited

Note-pane :- it is present above the status bar.it is used to enter
speaker notes

| 59 |
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Status bar : it contains view option,allow us to zoom in and zoom out
and use different viewing formats

Slide tab/Pane : it shows the miniature version (thumbnails) of the
slides .it also shows the order of slides in the entire presentation

4.1.6 How to make presentation

There are many ways of creating presentation in power point. These are as

follow

2 e

Blank presentation
Recent templates
Sample templates
Themes

My templates

New from existing

PATL sentation?”
Hame (LAY 4 Detign Trantfion Animation Shde Show Rrvew View POF
d save
Available Templates and Themes
[ Saveas
o Open @
4 Close \
1 - |
oo PN D i A LS L
Recert Blank Recent Sample Thaerres My templates  New from
presentation templates templates eugting
___  —— ]

Fig : 4.9 Showing different ways to create power point Presentation

4.1.6.1 Blank Presentation: it is a slide with blank background. In

the blank presentation we can insert text,background ,pictures
and other things in slides to create customized slide.

To create presentation through blank presentation:-
1. Click the File menu
2. Click on new

3. Under Available templates and themes, we see blank
presentation

4. Press enter
Or
Press ctrl+N

| so |
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4.1.6.2 Recent Template : It contains the recently used template by
the user.We can create presentation by using any of these
files.
To create presentation through Recent templates:
1. Click the File menu, and then click New.
2. Under Available template and themes, we can select

Recent template

3. Select template and Press enter.

4.1.6.3 Sample Templates : We can create presentation by using any
of these files. We can also download more templates from
internet.with this we can also create contemporary album
etc.
To create presentation through Sample template
1. Click the File menu, and then click New.
2. Under Available template and themes, we can select

sample template

3. Select any sample template of our choice e.g: contempo-
rary photo album,classic photo album etc and Press enter.

B 1T O Microsolt PowerHoint
Hame nied D vign Tranutinnn animatinng Side Show Revrw View

Avallable Tomplates amd Themes

Clagsis Phute Album

- €} Home » Sswple Lmpliter

s - E =
N Contermporary Phots Frve Rules

e

. .
2] ostons h - ﬁ- i

Irdtroehurgy Pusss et Pitihbok Progmt Statun Meprort

Fig:4.10Showing different sample templates

4.1.6.4 Themes : Theme are predefined colors, fonts, and effects.
these are used to make professionally designed presentation

To create presentation through Themes:

Introduction to Power Point Ill
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Click the File menu, and then click New.

Under Available template and themes, we select themes
option

Select anv theme of our choice and Press enter:

eilgn Transitions Animetions Elide Shew

-

Avallable Tempiates and Themes Adjecency

@ Horme ¥ Themes

__ =] ca @ |00

E e Eam

o Adjacency Angles Apen

Help —~ T . Cigate

2] opneans AA |"‘i Ea 1 -

Ed ea Emmew | cmmmm M

Apsthecary Aspect Austin
Fig:4.11 Showing different themes

4.1.6.5 My templates : it contains the collection of templates that we

have created earlier according to our choice.
To create presentation through My templates

Click the File menu, and then click New.

Under Available template and themes, we can select my
template

Select any personal template and Press enter.

Personal Templates

|§]m cersoral termolate

Precanbatinet

Fig:4.12 Steps to create power point Presentation through My templates
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4.1.6.6 To create presentation through New from existing
1. Click the File menu, and then click New.

2. Under Available template and themes, we can select

New from existing

3. Select any existing template of our choice and and Press

enter
@ New from Existing Presentation
OO 5 b Libraries » Documents » "}"1.” Search Documents Pl
Organize » Newr folder 2. [ @
LA = |
[P Microsoft FowerPo Documents library Morgs by Foldes +
Includes: 2 locations
W' Favorites MName Date modified Type
M Desktop |
& Downlnads = ) Bluetooth Folder 13-11-2024 0604  File folde
.;) Recent Places ). CyberlLink 24-05-2013 08:09 File folded
" samsung 04-09-2013 1547 File lolder
o YouCam 11-05-2012 07:44 File lolder
o Libraries L I + ile lolde
", Documents
& Pictures
B videos
& Comninter =] S il I r
File name: | ~ | ANl PowerPoint Presentations. v |
Tools = [ Open l [ Caneel |

Fig : 4.13 showing New from existing dialog box

4.2 To insert new slide : Add a new slide

1. On the Home tab, in the Slides group, click New Slide.
2. Select a slide thumbnail from the layout gallery.
Or
Press ctrl+M to insert new slide

- ——
; 7+ 0# Presentation2 - Microsoft PowerPoint Drawing Tools
m Home Insert Design Transitions Animations Slide Show Review View Format
iy J — e A (s
¥ : t- i I gy [ W - =
J - 5 Layou Calibri (Headings = 44 -~ A A 4‘{', i=-l=. dEE :E‘ ”u L| J) T
2 B Reset . s “id
Paste New AV, - - | = - Shapes Arrange
e B (Fl) TS BIUSMi-M A- EEEE E o ing
Clipboard 7 Slides Font " Paragraph

Fig:4.14 Steps to insert new slide in presentation
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4.3 Use of Layout and Autoshapes

4.3.1 Layout :

it is a simple design .it shows the position of an object on the slide. It
contains different types of the layouts. If we want to draw a chart on a slide, we
have to select slide layout related to the charts from slide layout pane. Slide
layout pane may contain following types of slides For example: we use title and
content option from office theme. In which following objects are used.

1) Tables

2) chart

3) Clip Art
4) Media clip
5) Smart Art
6) Picture

Click to add title

.chckmaddtext

=

.....mj ™

Fig 4.15 showing title and content Layout

Generally if we open any new slide the slide layout will open
automatically.we have to select the type of layout according to the slide, we want
to prepare

Iil Computer Science
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Steps to apply slide layout are given below :

1. Click on Home Ribbon

2. Select layout tool a pull down list will appear
3. Select the desired layout and press enter

' 'resentationi?Microsoft' PowerPoinﬂ

Home Insert Design Transitions Animations Slide Show

j . '| ' |-—|;__Caﬁm:i_&|rndinni.'_,44 > A° J7 | & = . 5:
b -3 Office Theme |
Paste hew ———————— =
Y. J Slide i l i'.‘.:::::;:‘.:‘.‘.1:2‘.:‘.‘.‘.::::::.‘5
Clipboard & : —an
T 3 Ty R '
Slides | Outline | o |k 1B | -
1 ' Title Slide Title and Content Section Header
o
Two Content Comparison Title Only
g
-3t 5
Blank Content with Picture with —
Caption Caption -

Fig : 4.16 Steps to apply slide layout

4.3.2 Clip Art and Smart Art

4.3.2.1 Clip Art:
It is a Picture gallery which contains clips related to different
category e.g: school,computer,bus,etc. The method to insert
clip Art is as follow:
1. Click Insert ribbon and Select the clip Art option

Introduction to Power Point Iil
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2. Now a pane related to clip art will appear on right hand.A
search box will appear now type the keyword for which we
are looking the image

3. Press enter

Presentatnom?.ﬁl-L Microsoft PowerPoint

Home Insert Design Transitions Animations Slide Show Review View

> : — = = ﬂ :. x =
Clip JScreenshot Photo Shapes SmartArt Chart Hyperlink Action Text Header V

Art o Album ~ v Box & Footer
Images Illustrations Links

Table

-

Tables

Fig 4.17 showing clip Art option

DRI e - Mirtemohtpomecboit m = @ B
- eow et Doge Tmitow  demexes  Sidelhov  Rery  Yew | fomal o @
1 ) i taout + Ja o . == gE L B\\aboD _]J P e - LY
. L 4 ALLUDD B TF W e outin - g Pephen

[ : oM LA E irreage
P LR T3mm VAN ) TR o} ke

T Rt Pasgy g

" Sy

Desweg 13 Firm

| s fer

i dedd
Al a1 g

Incude Ofon.com imetent

i ; | ) Pt s i ey oo
|: Click to add notes :G'vll!\bfhlnqﬁm

Fig 4.18 showing steps to insert clip Art
4.3.2.2 Smart Art:

it is a graphical way of representing our textual data e.g orga-
nization charts, flow charts, Venn diagrams, pyramids, etc.
This tool also have their own custom animation built in.it
also improve the aesthetic look of presentation .

Types of Smart Art

There are eight categories of Smart Art. Each category has
numerous designs to choose from.
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Fig:4.19 Showing smart Art
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Fig : 4.20 Showing smart Art relationship Category

Word Art :-

it is used to show text in different forms.it is a word art gallery
which contains different styles of writing words. Steps of writ-
ing word art are as follow:

1. Click on insert ribbon select word Art

2. Select the desirable style and click ok

3. Now type text

4.3.2.3

| 67 |
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Fig:4.21 Steps to write text using word art

4.4 Views of PowerPoint:

Slides in powerpoint can be seen in different ways. This is called view. We
can select the views according to our requirement. The different types of views
are:-

Normal View
Slide sorter view
Notes Page view

Reading view

A e

Master views: Slide, Handout, and Notes

NOTE : After completing our presentation we can see our presentation in
slide show view which is present in slide show tab or we can press F5 function
key from keyboard to see our slide in slide show view. Slide Show view is used
to deliver our presentation to the audience. it takes up the full computer
screen, like an actual presentation. In this view, we can see how our graphics,
timings, movies, animated effects, and transition effects will look during the
actual presentation.To exit Slide Show view, press ESC

Iil Computer Science
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1. Normal View:- it is the default and main view where we can edit
,write and design our presentation.Typically, Normal view includes
the Slides / Outline pane on the left. By default the Slides pane
(rather than the Outline pane) is active, and We can use this pane to
select slides.

2. Slide sorter view :- it is a view that provides us a view of our slides
in thumbnail form. This view makes it easy for us to sort and organize
the sequence of our slides .This view does not allow editing of the
material present on the slide

3. Notes Page :- The slide selected in this view appears on the top corner
and the information related to slide can be written at the bottom
portion. This information is called notes . We can also print notes to
hand out to our audience or include the notes in a presentation that
we send to the audience .

4. Reading view : This shows the slide with in the window and this view
is used to do proof reading. This view is used to deliver our presen-
tation not to an audience (via a large screen, for example), but instead
to someone viewing our presentation on the computer.

5. Master views : Slide, Handout, and Notes:-it include, Slide, Hand-
out, and Notes view. These are the main slides that store information
about the presentation, including background, color, fonts, effects,
placeholder sizes and positions. In this we can make universal style
changes to every slide, notes page, or handout associated with our
presentation.

4.5 Animation scheme, Transition

4.5.1 Animation scheme :

It is the ability to move objects in a slide.Special effects can be inserted on
photographs and voices with the help of animation . Animation schemes is used
to add present visual effects to charts,titles,paragraphs and bulleted items
.Animation scheme can be implemented by following method :-

1. Click on Animation Ribbon
2. Select the object on which animation has to be applied.

3. Click on Animation, choose the type of animation
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Fig : 4.22 Steps to apply animation scheme

4.5.2 Slide Transition:

During slide show in powerpoint a slide appears after the other is con-
trolled by slide transition.Slide transitions are the visual movements as one
slide changes to another. Powerpoint provides different transition effects to the
user like dissolve, fade etc.

steps for inserting transition effects are:-
1. Click on Transition Ribbon
2. Select the transition type

3. Select the transition sound,transition speed and advance slide option
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Fig: 4.23 Showing inserting transition effects

4.6 Exiting PowerPoint:
We can exit powerpoint when we complete and save our task. The different
ways to exit from powerpoint are given below:

1. Click on the file menu and select close option
Or

2. Click on cross button present on the right hand side of the title bar
Or

3. Press Alt+F4 Keys together

Polnts to Remember

1. Powerpoint is an application software used to make effective presen-
tation

A presentation is composed of several slides

Animation is the ability to move objects .

There are eight categories of smart art in powerpoint.

Ctrl+ M key is used to insert new slides in presentation.

Uk N
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FEXQ@U«@E&S@?}

I. Fill in the Balnks:-

1) is a presentation software
(a) Powerpoint (b) Word
(c) Excel (d) Paint
2) Power-point has views
@ 3 (b) 4
() 5 (d) 6
3) In view we cannot add the slide material
(a) Slide show (b) Normal
(c) slide sorter (d) None of these
4) Presentation can be made by methods.
@ 5 (b) 6
@ 7 (d) 8
5) There are categories of Smart Art.
@ 5 b) 6
(¢ 7 (d) 8

3. Short Answer type Questions
1) What is Powerpoint?
2) Write a short note on presentation .
3) Name different methods of preparing Presentation.
4) What is animation ?
5) Write a short note on slide.
3. Long Question Answers
1) Write a note on different types of views availableinpowerpoint
2) Write a short note on following terms:
i) Animation
ii) Layout
iii) Slide Transition
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1) Prepare Five slides

First slide : slide related to School

Second Slide : about infrastructure

Third Slide : About Computer lab

Fourth Slide : About Teachers

Fifth Slide : Best Thing about your school.
2) Insert atleast onepicture in each slide from clipgallery
3) Insert different animation effects in all slides
4) Use smart art in any one slide

5) Save presentation with the name of your school

Introduction to Power Point Ill
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Advance Power Point

OBJECTIVES OF THIS CHAPTER :

5.1 Changing Appearance of Slide
5.1.1 Changing the design theme.
5.1.2 Changing Colour scheme
5.1.3 Changing Background style
5.1.3.1 Changing the background pattern or texture fill
5.1.3.2 Changing the Gradient
5.2 Inserting an Object
5.3 Inserting the picture
5.4 Inserting Movie/ Video files

INTRODUCTION

In the last Chapter we have learnt about basics of power point. In
this chapter we will learn advanced features of power point. Power Point is a
presentation package. In slides we can insertpictures, charts, movies and
videos,objects to make our presentation more effective. In this chapter we will
learn to change Design template, colour scheme,gradient, texture, background
styles etc. The advanced techniques of power point make our presentation more
presentable in very less time

5.1 Changing the Appearance of Slide:

Power Point provides us the facility to change complete appearance of
slide by changing the background, design, colour scheme, background colour,
texture, pattern and gradient.To make our slide more presentable and clear we
can insert objects,pictures,movie and video clips.
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5.1.1 Changing Design Themes:

Power Point provides different Themes that we can apply to a presenta-
tion to give a fully designed look. It has predefined background
design,textstyle,colour etc.it can be used in single slide or more than one slides.
There are various Themes template used in power Point.

Stepsare as follow:

1. Select a slide in which we want to apply new design.

2. Click on the Design tab

3. Ribbon Shows various themes in Themes Group, select the theme of
your choice

4. New Theme will be implemented.

— e

Presentation3= Microsoft PowerPoint” | Drawing Tools.
Insert Design Transibions Animation: Slide Showr Review Yiew Format

This Presentation =
Aa

.. |
Built-In I
Aa Aa

amom. o - mnm

Al |Aa

[ Y S EoEEEE

Aa Aa

EmoEEn "

e= -n =,

Enable Content Updates from Office.com..
l,;;] Browse ron Themes

45 Save Current Theme.

Fig 5.1 Showing different Themes

5.1.2 Changing Colour scheme

We can change the colour of text.lines,title etc. by applying colour
scheme on slide .With this we can change background as well as foreground
colours:
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Steps are as follow :-

1. Click on Design Tab

2. On the Ribbon select the colors option in Theme group

3. In the drop down list select color scheme

4. Click the desired color.
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Fig 5.2 Steps for changing colour Scheme

5.1.3 Changing Background styles

We can change background colours of all slides or any selected.

Steps for changing background are as follow:

1. Click the Background Styles button on the Design Tab.

2. Move the mouse over any of the background styles.

3. The background style will be reflected on the slide

4. Click the mouse when we find a background style that we like.
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n Colors ~ (R .
el lv_"l Background Styles

Fig 5.3 Steps for changing Background styles

-

r )
L i

) Format Background...
“_] Reset Slide Background

5.1.3.1 Changing the Background Pattern or texture fill

We can add picture to the background of slide and texture can also be
changed
Steps to change Picture:

Click the Background Styles button on the Design Tab.
Click on format background

Format background dialog box will appear

Select Fill Option, then Select picture or texture fill option

Select Insert from File , Clipart or clip board

& ok W=

If we selectinsert from File option the insert picture dialog box will
appear

Select the required picture.
Click apply to all slides.
Click on Close button.

10. Picture will insert into our slide
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Fig 5.4 Steps for changing Picture

Steps to change texture : Format Background IR
1. Click the Background @ * |l
Styles button on the . .. s
Design Tab. ety || A2 A
2. Click on format back- 3:;::“??““
ground et "
Be..
3. Format background M e
dialog box will appear i
4. SelectFill Option then T‘:f A
Selectpicture or texture v by
fill option Torsgers

Rtz

5. From the Texture drop
down list select the re-
quired texture

6. Click apply to all slides.

7. Click close button

8. The Texture will be
implement to our slides Fig 5.5 Steps for changing Texture
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5.1.3.2 Changing the Gradient

With the help of gradient we can make our presentation more attractive
Steps:

Click the Background Styles button on the Design Tab.

Click on format background

Format background dialog box will appear

Select Fill Option then select Gradient Fill radio button

aos Wb o=

Under Preset colour Option , Select color,Type, direction,angle,stop
position according to our choice.

Click apply to all slides

The Gradient will be implement

Format Background 2 IEN

| i Fill

Picture Corrections | | () Solid &l

Bicture Color (®) Gradient fil

() Bicture or texturs fill

() rauemn fil
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Fig 5.6 Steps for changing presetcolors under Gradient Fill option

5.2 Inserting an Object in power point

Application like worksheet,bitmap,excel chart,clip Art etc can be inserted
in power point presentation.

Advance Power Point I 79 I

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

Steps to insert objects:-

1) Click where we want to insert Object.

2) On the Insert tab, click Objectoption in Text group.
3) Insert Object Dialog box will appear

4) Select the object type: bitmap image,wordpad document etc we want
to insert

5) Click ok

@Imm Animations  SlideShow R

B2 Q: UJAEGQ@

Cip | Photo Shapes SmartArt Chart  Hyperlink -(‘lmn Text Header WordArt Date Slide Symbol
At ‘Album- ~ Box & Footer . & Time Number

Hlustrations Links Text

Inserts a new Adobe Acrobat Document object into your

- |

Fig 5.7 Steps for Inserting object

5.3 Inserting the picture
In order to make our presentation more presentable we can insert pic-
tures in our slide.
Steps:
Click where we want to insert the picture.
On the Insert tab, click Picture option in images group
Insert Picture dialog box will appear

Select the picture we want to insert and click open

S

Picture of our choice will be inserted.
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Fig 5.8 Steps for Inserting Pictures

5.4 Inserting Movie/ Video files

While inserting movie into our presentation, we have three options:-

1) Through video from File

2) Through video from website

3) Through Clip Art Video / Clip Organizer

To insert video from a file in our presentation:

1) Select the slide where we wish to insert the video.

2) Select the Insert tab.

3) Click on the video command in the Media group.

4) Select video from File Option . The Insert video dialog box will appear.
5) Locate the file we want to insert from our computer.

6) Click the file .

Advance Power Point I 81 I

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

7) Click OK.

8) The video will appear on the slide.
The video Tools Options appears when the video is inserted.
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Fig 5.9 (i) Steps for Selecting video from video library
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Fig 5.9 (ii) showing videothat is inserted
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To insert video from a website

Select the Insert tab.

2. Click on the video command in the Media group andclick the arrow
under Video

3. In the Video From Web Site dialog box, paste the embed code, and
then click Insert.

To insert video from Through Clip Art Video (clip Organizer):

Clip organizer is used to store animated clips,videos,Photos and other
media.Clip gallery is an animated clip like clipart. In order to insert movie from
clip gallery follow the following steps

1) Firstly select Normal view

2) From the insert Tab ,Click video optionfrom Media Group and then
click Clip Art Video

3) Clip Art search box will appear ,Now search for the required clip
4) Select the clip then selected clip will be inserted.
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Fig 5.10 Steps for Inserting animated clip through Clip Art Video
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&

Points to Remember

Themes are predefined background design, text style, colour

Different objects can be inserted in slides of power point like worksheet,
bitmap, excel chart, clip Art etc

Movie /video can be inserted in the following ways:

i. Through video from File

ii. Through video from website

iii. = Through Clip Art Video / Clip Organizer

Colour scheme has predefined color that changes the colour of text,
lines, title etc.

Clip Organizer is used to store animated clips

FEX&@U«G:E@@‘.H

1. Fill in the blanks

1.

Gradient option is present in dialog box.

(a) Format Shape (b) Format Background
(c) Paragraph (d) Font

Video can be inserted in ways.

(a) 1 (b) 2

(¢ 3 (d) 4

Through clip Art Video,video from website and are the three
ways in which video is inserted.

(a) video from file (b) Through image

(c) Through animation (d) All of these

Word Document, bitmap, worksheet is inserted through

(a) insert Tab (b) View Tab

(c) Home Tab (d) None of these

Iil
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5. Background Style button is available on ribbon.
(a) Animation (b) Design
(c) Home (d  Insert

2. True/False
1. Themes are predefined background design, text style, colour
2. Different objects cannot be inserted in slides
3. Color scheme can not be applied on slide
4. Clip Organizer is used to store animated clips
3. Short Answer type Questions:
1. Name the different ways in which appearance of slide can be changed.
2. What is the use of colour scheme?
3. Write about clip Organizer.
4. Explain Themes.
5. Name different objects that can be inserted in Powerpoint.
4. Long Answer type questions:
How we can insert video into our presentation? Explain the steps.
What is colour Scheme? Write steps to change the colour scheme.
Write steps to change Background style.
Give steps to add picture in the background of slide.

AR

Write steps to insert object in Power Point.

Lab Activity-5.1 Appearance of slide

Lab Av.-5.1.1 Make four slides as given below:

1. First : Network Topology
Ways in which one or more computers are linked together.
Second : Table showing number of topologies

Advance Power Point I 85 I
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Serial No Name of topology

1 BUS
RING
STAR
MESH

oW N

Third
Fourth
Lab Av.--5.1.2

Lab Av.--5.1.3
Lab Av.--5.1.4

LabAv.--5.1.5

Lab Activity-5.2.
Lab Av.--5.2.1

Lab Av.--5.2.2

Lab Av.--5.2.3.

Lab Activity-5.3.
Lab Av.--5.3.1
Lab Av.--5.3.2
Lab Av.--5.3.3

Table No:1
BUS TOPLOGY

All Computers are connected to a single wire
RING TOPLOGY
All computers are connected in a circle like a ring
Applyany theme .
Change the colour scheme

Addrelevant pictures in background of slidese.g.in
3rd slide picture of bus topology Similarly, 4th slide
picture of Ring Topology .

Save the Presentation with name topology.

Insert Objects:
Create slides as follows:
Firstslide : Insertbitmap image.

Second Slide : Insert Worksheet and make table nol as
shown in Lab Av.-5.1.1 Slide no 2 .

Third Slide : insert a bitmap image and draw star topol-
ogy in bitmap image

Change the colour of first slide to blue

Save the slide with the name objects_topology.

Insert Video:
Open Blank presentation.
Make the title Showing video.
Insert video from file.

A
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Introduction
to MS Excel

OBJECTIVES OF THIS CHAPTER :
6.1 Introduction to Ms Excel
6.2 Various uses of MS-Excel
6.3 How to start Ms Excel
6.4 Parts of Ms Excel Window
6.5 Terminology used in Ms Excel
6.6 Working in Worksheet of Ms Excel
6.7 Saving a File
6.8 Closing Excel

6.1 Introduction to Ms Excel :

Electronic spreadsheetisused for monitoring and analyzing the data, and
present the data in pictorial form by using charts. Some of commonly used
spreadsheet packages are Tally, Lotus and Microsoft Excel.

Microsoft Excel is a spreadsheet program used for organizing and calcu-
lating numerical data. We can use it to organize our data into rows and
columns and to perform mathematical calculations. Excel can also produce a
range of charts and graphs that can be used to present the data in a graphical
manner.

6.2 Various uses of MS-Excel

1) Excel can be used for mathematical calculations.

2) In Excel data can be represented in a graphical format in the form of
Charts.

3) We can prepare the school Timetable.
4) Salaries of employees can be calculated.

5) Results of students can also be prepared in Excel.
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6.3 How to startMs Excel :

To open Ms Excel window click on:

p—

Start - — All Programs —— Microsoft Office — Microsoft Office Excel

OR
Type "Excel" in search bar and press enter button from keyboard.

|Search programs and files pel

Fig. 6.1 Search bar

The figure shows the main parts of Ms Excel Window :

Minimze
Tabs Formula Title bar Column aximize
Bar Close

File Meru Quick Access

Ribbon e[, 1% .
Group (Fonl)— ™ ' 823 Gno o  Jraat ‘;
- Al . 1] - - '.
Ee:l#\:ldeass(ﬁt) : LT ; . - i . : . v I M I 8o W ol i i 1 "_J
ell >
Row ]

MRS BN ESEEEEEE B e e

Sheets(Sheat:1 2.3) Insen Status Bar Harizontal Docurment Zoom in
New Scroll Bar View Zoom out
Worksheet

Fig. 6.2 Ms Excel Window
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6.4.1 The File Menu :

In the upper-left corner of the Excel window is the File Menu. When we
click the option, a newwindow appears. We can this window to create a new file,
open an existing file, save a file, and perform many other tasks.

Fig. 6.3 File Menu

6.4.2 The Quick Access Toolbar :

Above the File Menu there is the Quick Access toolbar. The Quick Access
toolbar gives us access to commands we frequently use. By default, Save, Undo,
and Redo appear on the Quick Access toolbar. We can use Save to save our file,
Undo to roll back an action we have taken, and Redo to reapply an action.

Fig. 6.4 Quick Access Toolbar

6.4.3 The Title Bar :

Next to the Quick Access toolbar is the Title bar. On the Title bar, Microsoft
Excel displays the name of the workbook we are currently using. At the top of
the Excel window, we can see "Microsoft Excel - Bookl" or a similar name.

= —.‘ T
Book1 - Microsoft Excel

Fig. 6.5 Title Bar

6.4.4 The Ribbon :

In Microsoft Excel, we use the Ribbon to issue commands which tell
Microsoft Excel what to do. The Ribbon is located near the top of the Excel
window, below the Quick Access toolbar. At the top of the Ribbon, there are
several tabs. Each tab displays several related command groups. We must
click buttons to issue commands or to access menus and dialog boxes.
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We may also find a dialog box launcher in the bottom-right corner of every
group. When we click on it, a dialog box makes additional commands available.

fda A8 s T T
Fome | haet  Migtleodt  Fomuls Dol Feew Ve Tue s@=dE
j : i Ll ‘M AN | Ty ® St Jevea . h: if ‘. "_" a ;.‘ . ;'|7 ﬂ
M Jremane| B 7 815 8- A (B RE Bionsrioan- 1% 5 (208 Comma ot oo | bt oo 5, St oD
us - £ I
Font (Group) Ribbon

Fig. 6.6 Ribbon

6.4.5 The Formula Bar :

In the Formula bar the cell address of the active cell is displayed in the
Name box which is located on the left side of the Formula bar. Cell entries are
displayed on the right side of the Formula bar. If we do not see the Formula bar
in our window, perform the following steps:

1. Choose the View tab.

2. Click Formula Bar in the Show/Hide group. The Formula bar ap-
pears.

Note : When we enter a formula in a cell, it is displayed in the Formula bar.

Al vy fe

Fig. 6.7 Formula Bar

6.4.6 The Status Bar :

The Status bar appears at the bottom of the Excel window and provides
information such as the sum, average, minimum, and maximum value of se-
lected numbers. We can change what displays on the Status bar by right-
clicking on the Status bar and selecting the options we want from the Customize
Status Bar menu. We click a menu item to select it. We click it again to deselect
it. A check mark next to an item means the item is selected.

- R

Fig. 6.8 Status Bar
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6.4.7 The Name Box :

We can also use the Name box to go to a specific cell. Just type the cell
we want to go to in the Name box and then press Enter. For example follow the
steps written below:

1. Type B4 in the Name box.

2. Press Enter. Excel moves to cell B4.

_::j :’.i':“ o ER PR L BT IE TR
foe Sromuramay (B LU E DA BBW =x
Trpbrare fa Fomt f Algrmen|
Bt . @ &
Pl _A Bl ¢ D
1
2
3
'l
)
e
7
8

Fig. 6.9 Name Box

6.5 Terminology used in Ms Excel :

Following are terms used in Excel:

6.5.1 Workbook :

A workbook is a collection of many worksheets. By default, each workbook
contains three worksheets.

6.5.2 Worksheet :

Worksheet contains columns and rows. We can insert more worksheets in
workbook by pressing the button "Insert New Worksheet".

6.5.3 Row :

Rows placed in a horizontal (left to right) arrangement of a series of cells.

Rows are labeled 1, 2, and 3 and so on. A maximum of 10,48,576 rows are
available in worksheet.
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6.5.4 Column :

A column is a vertical (Top to down) arrangement of a series of cells. The
columns are labeled A to Z and then continuing with AA, AB, AC and so on till
XFD. A maximum of 16,384 columns are available in worksheet.

6.5.5 Cell :

A cell is an intersection of a row and a column. Each cell is identified by
a cell address. We enter our data into the cells on the worksheet.

6.5.6 Active cell :

This is the cell in which we are currently working. A bold rectangular box
around the cell identifies an active cell.

6.5.7 Cell Address :

Every cell in Excel has a unique celladdress. A cell address has a
column letter followed by a row number. For example Al is the intersection
of the column A and row 1. The combination of a column coordinate and a
row coordinate make up a cell address. For example, the cell located in the
upper-left corner of the worksheet is cell A1, meaning column A, and row 1.
Cell F3 is located under column F on row 3. Cell C6 is located under column
C on row 6.

i—j‘r ;'::' Catipn T .|'II|'--!I‘"| Sfwnp Ted Gintri

s F Formet Raintsr | B4 n"'w"l‘.b'ﬂ"_|l"-'ll: si{torge & Contar = |4 ¢ om0 (%
Tewuerg = | Fars & Algnmem 5 Humber
U * s e

wL..A. .8 . .¢c 1l o [ e I F Il G

1 Al

2 ————

3 F3

4

5

6 c6 |

7

8

9

10

Fig. 6.10 Cell Address
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6.6 Working in Worksheet of Ms Excel

6.6.1 Using the arrow keys :

We can move around our worksheet by using arrow keys. We can use
the down arrow key to move downward one cell at a time, up arrow key to
move upward one cell at a time. We can use the Tab key to move across the
page to the right, one cell at a time and can hold down the Shift key and then
press the Tab key to move to the left, one cell at a time. We can use the right
and left arrow keys to move right or left one cell at a time. The Page Up and
Page Down keys move up and down one page at a time. If we hold down the
Ctrl key and then press the Home key, we move to the beginning of the
worksheet e.g. Cell Al.

6.6.2 Selecting Cells :

If we wish to perform a function on a group of cells, we must first select
those cells by highlighting them as shown in figure below:

:. :;:. i S ARy e e Camarad ‘ m d

Mt Fromreae B4 BAE S Ae] (B WP Hrrepen s ([8- 8% 2 [j3 A Conen o
] “ ot 5 ihgmpes - Hamne - e
r - - %

PhuA Bl D E | F | G

1

2

3

4

s

6

7

8

9

10

11

Fig. 6.11 Selecting Cells

We can select an area by holding down the left mouse button and drag-
ging the mouse over the area.

6.6.3 Entering Data :

We can enter data in into our worksheet. First, place the cursor in the
cell in which we want to start entering data. Type some data, and then press
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Enter. If we need to delete, press the Backspace key to delete one character at
a time.

B :: - A [ -]
e et B HAS A (]
Crobasa ) Pout s preee
A Qualufel Compae
ol B & D
1 Computel\
; J
3
4 |
5
6
7
8
9. |
10

Fig. 6.12 Entering Data

6.6.4 Deleting Data :
The Backspace key erases one character at a time in the active cell.

6.6.5 Editing a Cell Data :

After we enter data into a cell, we can edit the data by pressing F2 while
we are in the cell we wish to edit. We can also edit the cell by using the Formula
bar or can also edit the data by double clicking the cell we want to edit.

6.6.6 Wrap Text :

When we type text that is too long to fit in the cell, the text overlaps the
next cell. If we do not want it to overlap the next cell, we can wrap the text.

Follow the steps written below to wrap text:
1. Move to cell A2.

2. Type Text too long to fit.

3. Press Enter.
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Fig. 6.13 Wrap Text
4. Return to cell A2.

Choose the Home tab.

6. Click the Wrap Text button . Excel wraps the text in the cell as shown
in figure below.
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Fig. 6.14 Wrap Text
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6.6.7 Delete a Cell Entry :

To delete an entry in a cell or a group of cells, we should place the
cursor in the cell or select the group of cells and press Delete key from the
keyboard.

6.6.8 Filling a range of cells

® Select type the first cell of the range you want to fill.

® Type the desired data.

® Now, press fill handle with left mouse button and drag the mouse.
Or

® From keyboard Press the Shift and down arrow key and select the
cells or range of cells. Release both keys and press Ctrl + D to fill the
data.

® This will copy the content of first cell to all the cells of the selected
range.

range A B €
range
range
range
range
range
range

ra ﬁ§¢

[ e e e e el

Lt el =
N8 vovewowawnNr

‘Bmmummbmmp

Fig. 6.15 Filling a range Fig. 6.16 Filling a range

6.6.9 Creating a Series

follow steps to create a series.
® Enter the value Monday (fig 6.17) or 1 (fig 6.18) in cell Al
® Enter the value Tuesday (fig 6.17) or 2 (fig 6.18) in cell A2
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@® Select both of the cells and press fill handle with left mouse button
and drag the mouse

@® This will create the series.

- ;(:z P i Ay ESm=le ] ':;:i [ 1n -
N mraee (B4 02O A N rome vt | B2 M= () -
M. £ | Monday I : '1" - fu
A B C A B C
1 |Monday 1 1
2 [Tuesday 2 2
3 [Wednesday 3 3
4 |Thursday 4 4
5 |Friday 5 5
& [Saturday b 6
7 |Sunday 7 7
8 8
9 9
10 10
Fig. 6.17 Creating a Series Fig. 6.18 Creating a Series
6.7 Saving a File:

To save our file, follow the steps written below:

1. Click the File Menu. A window will appear.

2. Click Save. The Save As dialog box will appear.

3. Go to the Folder in which we want to save our file.

4. Type suitable name for file in the File Name field.

5. Click Save. Excel will save our file.

6.8 Closing Excel:

Steps to close Microsoft Excel are:

1. Click on the File menu. A window appears.

2. Click on exit. Excel will close.

* Before closing Excel , always save your workbook.
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10.

Points to Remember

Microsoft Excel is a spreadsheet program used for organizing and
calculating numerical data

Salaries of employees and Results of students can be prepared in
Excel.

Worksheet contains columns and rows. We can insert more worksheets
in workbook by pressing the button "Insert New Worksheet.

Rows are the square or rectangle boxes placed in a horizontal (left to
right) arrangement of a series of cells.

A column is a vertical (Top to down) arrangement of a series of cells.
A maximum of 16,384 columns are available in worksheet

Each cell is identified by a cell address. We enter our data into the
cells on the worksheet

Active cell is the cell in which we are currently working. A bold rect-
angular box around the cell identifies an active cell

We can select an area by holding down the left mouse button and
dragging the mouse over the area.

We can edit the data by pressing F2 while we are in the cell we wish
to edit.

F_E.'fxg@m’«ﬂ:iﬁg@ﬂ

1. Fill in the blanks:

1.

A workbook is a collection of the .
(@ Cell (b) Row

(c) Column (d) Worksheet

By default, each workbook contains worksheets.
(@ 2 (b) 3

© 4 (d) 5

A maximum of rows are available in worksheet.
(a) 1048576 (b) 16384

(C) 984664 (d) 36524

A
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A maximum of columns are available in worksheet.
(@) 83254 (b) 16384

(0 10520 (d) 65536

A cell is an intersection of a _ and a .

(a) Row ,Column (b) Row , Cell Address
(c) Column,Formula Bar (d) None of these

Cell is the cell which we are currently working.

(a) Dead (b) active

(c) working (d) None of these
Every in Excel Sheet has unique address .
(@) Cell (b) Row

(c) Column (d) worksheet

2. True/False:

1.

AR

Excel can be used for mathematical calculations

The Status bar appears at the top of the Excel window

When we enter a formula in a cell, it is displayed in the Formula bar
The Ribbon is located near the bottom of the Excel window.

To open Ms Excel, type "Excel" in search bar and press enter button
from keyboard

3. Short Answer type Questions:

4.

R C R S N TR e

What are various uses of MS-Excel
List the parts of Ms Excel Window
Define the Formula Bar

What is Active cell in Ms Excel?

How to insert more worksheet in workbook of Excel

ng Answer type Questions:

Explain the Terminology used in Ms Excel
How to Wrap Text in Ms Excel

Write about filling a range of cells in Ms Excel
Write about Creating a Series in Ms Excel

How to save our file in Ms Excel
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Memory Units
and Generations

OBJECTIVES OF THIS CHAPTER :

7.1 What is Memory
7.1.1 Memory Units
7.2 Types of Memory
7.2.1 Internal Memory
7.2.1.1 Cache memory
7.2.1.2 Primary/Main memory
7.2.1.2.1 RAM
7.2.1.2.2 ROM
7.2.2 External Memory
7.2.2.1 Sequential Access
7.2.2.2 Direct Access
7.3 Physical Structure of Magnetic disks
7.3.1 Tracks and Sectors

7.4 Generations of Computers

7.1 What is Memory?

Memory of computer system is just like a human brain. The memory
is the storage space in computer where data to be processed and instruc-
tions required for processing are stored. It can keep all the necessary data
and operations for a computer to function.The memory is divided into large
number of small parts called cells. Each location or cell has a unique
address.
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7.1.1 Memory units :

Memory capacity of a computer is the amount of data that can be stored
in the storage unitwhich is equal to the numberof bytes that can be stored in its
storage unit. The storage capacity is expressed in terms of Bytes. Following are
the main memory storage units:

® Bit (Binary Digit ): A bit or a binary digit may be represented by
logical O and 1.

® Nibble : A group of 4 bits is called nibble.

® Byte : A group of 8 bits is called byte. A byte is the smallest unit
which can represent a data item or a character.

® Word : Acomputer word is a group of fixed number of bits pro-
cessed as a unit.The length of a computer word is called word-size
or word length. It may be as small as 8 bits or may be as long as
96 bits. A computer stores the information in the form of computer

words.
Measuring Units for Computer Memory:
Sr. No. Memory Unit Discription
1 Bit Single Binary digit either O or 1
2 Nibble Group of 4 bits
3 Byte Group of 8 bits
4 Kilobyte (KB) 1 KB = 1024 Bytes
5 Megabyte (MB) 1 MB = 1024 KB
6 GigaByte (GB) 1 GB = 1024 MB
7 TeraByte (TB) 1 TB = 1024 GB
8 PentaByte (PB) 1 PB = 1024 TB
Fig :7.1Measuring Units for Computer Memory:
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7.2 Types of Memory:

Following Figure shows the basic classification of Memory units.

CPU Registors

internal

‘ Cache Memory Memary

Speed :
Increases ‘ faie Hiesioy
As we move up
l Magnetic Disk
3
External
I Optical Disk Memory
[ Magnetic Tane |

Fig : 7.2 Types of Memory:

Memory can be classified into two main categories:
7.2.1. Internal memory
7.2.2. External Memory

7.2.1 Internal Memory :

The instructions of a program and data need are placed where work can
be done on them. The CPU uses internal Registers and cache Memory for this
purpose. The Internal Memory can further be divided into two categories:

I GEGE]
memory

Primary
Memory

Fig : 7.3 Classification of Internal Memory:
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7.2.1.1 Cache Memory:

Cache memory is a very high speed semiconductor memory which can
speed up CPU. It acts as a buffer between the CPU and main memory. It is used
to hold those parts of data and program which are most frequently used by
CPU. The parts of data and programs are transferred from disk to cache memory
by operating system, from where CPU can access them.

Advantages of cache memory:

The advantages of cache memory are as follows:

Cache memory is faster than main memory.
It consumes less access time as compared to main memory.

It stores the program that can be executed within a short period of
time.

It stores data for temporary use.

Disadvantages of cache memory:

The disadvantages of cache memory are as follows:

Cache memory has limited capacity.

It is very expensive.

7.2.1.2 Primary/Main memory :

Primary memory holds only those data and instructions on which com-
puter is currently working. It has limited capacity and data is lost when power
is switched off. It is generally made up of semiconductor device. These memories
are not as fast as registers. The data and instruction required to be processed
reside in main memory.

Fig : 7.4 Primary/Main memory:
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Characteristics of Primary Memory
® These are semiconductor memories and are known as main memory.

® It is usually volatile memorybecause data is lost in case power is
switched off.

® It is working memory of the computer.
® It is faster than secondary memories but slower than CPU registers.
® A computer cannot run without primary memory.

It is divided into two subcategories
RAM and ROM.

7.2.1.2.1 RAM :

RAM stands for Random Access Memory. It is the internal memory of the
CPU for storing data, program and program result. It is read/write memory
which stores data until the machine is working. RAM is volatile memory that
means data stored in it is lost when we switch off the computer or if there is a
power failure. This is the reason a backup uninterruptible power system(UPS) is
often used with computers. Data in the RAM can be accessed randomly it is very
expensive. RAM is small, both in terms of its physical size and in the amount
of data it can hold. Further RAM is of two types:

® Static RAM (SRAM):

The word static indicates that the memory retains its data as long as
power is being supplied. However, data is lost when the power gets down due to
volatile nature. SRAM chips use a matrix of 6-transistors and no capacitors.
Transistors do not require power to prevent leakage, so SRAM need not have to
be refreshed on a regular basis.

Characteristic of the Static RAM
It has long life

There is no need to refresh it.
It is faster

It is used as cache memory

It is large in size

It is expensive

It is consumes high power .
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® Dynamic RAM (DRAM):

DRAM must be refreshed in order to maintain the data. This is done by
placing the memory on a refresh circuit that rewrites the data several hundred
times per second. DRAM is used for most system memory because it is cheap
and small. All DRAMs are made up of memory cells which are composed of one
capacitor and one transistor.

Characteristics of the Dynamic RAM
It has short data lifetime

It need to be refreshed continuously
It is slower as compared to SRAM
It is used as RAM

It is lesser in size

it is less expensive

® [t consumes less power.

7.2.1.2.2 ROM :

ROM stands for Read Only Memory. This is the memory from which we
can only read, but cannot write on it. This type of memory is non-volatile that
means the information is stored permanently in such memories during the time
of manufacturing. A ROM, stores such instructions that are required to start a
computer. This operation is referred to as bootstrap. ROM chips are not only
used in the computer but also in other electronic items like washing machine
and microwave oven etc. It is also called FIRMWARE.

Fig : 7.5 ROM
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Following are the various types of ROM:
® MROM (Masked ROM):

Earlier ROMs were hard-wired devices that contained a pre-programmed
set of data or instructions. These kinds of ROMs are known as masked ROMs
which are inexpensive.

® PROM (Programmable Read only Memory)

PROM is read-only memory that can be modified only once. We can buy
a blank PROM and enters the desired contents using a PROM program. It can
be programmed only once and is not erasable.

® EPROM(Erasable and Programmable Read Only Memory)

The EPROM can be erased by exposing it to ultra-violet light for the
duration of up to 40 minutes. During programming, an electrical charge is used.
This charge can be retained for more than ten years. For erasing this charge,
ultra-violet light is passed.

® EEPROM(Electrically Erasable and Programmable Read Only
Memory)

The EEPROM is programmed and erased electrically. It can be erased and
reprogrammed about ten thousand times. Both erasing and programming take
about 4 to 10 ms (milliseconds). In EEPROM, any location can be selectively
erased and programmed. EEPROMs can be erased one byte at a time, rather
than erasing the entire chip. Hence, the process of re-programming is flexible
but slow.

* millisecond =1/1000 of a second

Advantages of ROM:

The advantages of ROM are as follows:

® It is non-volatile in nature.

® These cannot be accidentally changed.

® [t is cheaper than RAMs.

@® It is easy to test and more reliable than RAMs
L

These are static and do not require refreshing.
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7.2.2 External Memory :

This type of memory is also known as secondary or auxiliary memory or
non-volatile. It is slower than main memory. These are used for storing data and
Information permanently. CPU does not access these memories directly. They
are accessed via input-output routines. Contents of secondary memories are
first transferred to main memory, and then CPU can access it. For example:
Hard disk, CD-ROM, DVD etc.

Fig : 7.6 External Memory (HDD)

Characteristic of Secondary Memory :

These are magnetic and optical memories.

Backup / Reusable memory:data stays in the secondary storage on
permanent basis until it is not overwritten or deleted by the user.

Non-volatile memory: Data is permanently stored even if power is
switched off.

Reliable:Data in secondary storage is safe because of high physical
stability of secondary storage device.

Convenience:With the help of computer software, authorized people
can locate and access the data quickly.

Capacity:Secondary storage can store large volumes of data in sets of
multiple disks.

Cost:It is much lesser expensive to store data on a tape or disk than
primary memory.

Computer can start without secondary memory.

Slower than primary memories.

Memory Units and Generations
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The following figure illustrates the types of External/Secondary Memory

devices. They are mainly of two types:
7.2.2.1 Sequential Access Devices

® Magnetic Tapes
7.2.2.2 Direct Access Devices
L Magnetic Disks
o Floppy disks
o Hard disks
[ Optical disc
o CD
o DVD
[ Memory Storage devices
o Flash derive

o Memory card

Secondary Storage
Devices

Sequential Access Direct Access Devices

Device

Magnetic Tape

— T

Flash
Floppy Hard CD-ROM . :
Diak Disks WORM CD-RW DVD  prive

| (CD-R)

Magnetic Optical Disks Memory Storage
Disks Devices

Memory
Card

Fig : 7.7 Types of External/Secondary Memory devices
7.2.2.1 Sequential Access Devices :

In these type of storage devices data can only be retrieved in sequential
order, in whichit is stored. These are suitable for sequential processing appli-
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cations where most of the data records need to be processedone after another.
Magnetic tape is a good example of such types of storage device.

Data storage capacity is the amount of data that can bestored on a given
length of tape. It is measured in bytesper inch (bpi)

Storage capacity of a tape =Data recording density x Length

7.2.2.2 Direct Access Devices :

In these storage devices any storage location may be selectedand
accessed randomly. They permits access to individual information in a
moredirect or immediate manner. These are suitable for direct processing
applications such as onlineticket booking systems, on-line banking systems.
Magnetic, optical, and magneto-optical disks are examples of direct access
storage devices.

7.3 Physical Structure of Magnetic Disk :

The figure shows the physical structure of magnetic disk.

7.3.1 Tracks :

The surface of disk is divided intoa number of invisibleconcentric circles
called tracks. These tracks are numberedconsecutively from outermostto inner-
most starting fromzero. The number of tracks on adisk may vary according to
the capacity of disks.

Track 000

Tracks

7

Fig : 7.8 Tracks
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7.3.2 Sectors :

Each track of a disk issubdivided into small portions known as sectors.
There are 8 or moresectors per track. A sector typically contains 512 bytes.

A i
Ww,,,w secto

mm
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\\““-:.__"" —
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Fig : 7.9 Sectors

Storage capacity of a disk system may be calculated by using the following
formula:

Storage capacity = Number of recording surfaces x Number of tracks per
surface x Number of sectors per track x Number of bytes per sector

7.4 Generations Of Computer:

In computer terminology, Generation is a change in technology of
computer. Earlier, the generation term was used to distinguish between
varying hardware technologies. But nowadays, generation includes both
hardware and software, which together make up an entire computer
system.There are totally five computer generations known till date. These
are explained as followed:

7.4.1 First Generation Computers (1942-1955) :

The time period of first generation was 1942-1955. The first generation
computers used vacuum tubes as the basic components for memory and
circuitry for CPU (Central Processing Unit). These tubes were like electric
bulbs which produced a lot of heat and were prone to frequent fusing.
They were very expensive and could be afforded only by very large
organizations.
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Figure 7.10 Vacuum Tube

In this generation, mainly batch processing operating systems were used.
Punched cards, Paper tape and Magnetic tapes were used as Input & Output
devices. Machine codes and electric wired board languages used to operate the
machines.

Main features and characteristics of First Generation:

Vacuum tubes as basic component, Electromagnetic relay memory;
Punched cards as secondary storage were used.

Machine andAssemblylanguages and stored program concept for op-
erating the machines were used.

They were very much bulky in size and produce a lot of heat.
They were not much reliable systems.
They cannot be commercially used.

They were costly and difficult to use.

Names of First Generation Systems:

ENIAC
EDVAC

Memory Units and Generations
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® EDSAC
® UNIVACI
® IBM 701

7.4.2 Second Generation (1955-1964) :

The time period of second generation was 1955-1969. This generation
used the transistor as their basic component. They were cheaper, consumed
less power, more compact in size, more reliable and faster than the first genera-
tion machines made of vacuum tubes. In this generation, magnetic cores were
used as primary memory and magnetic tape and magnetic disks as secondary
storage devices.

Figure 7.11 Transistor

In this generation, assembly language and high-level programming lan-
guage like FORTRAN and COBOL were used.Batch processing and Multipro-
gramming Operating system were also used.

Main features and characteristics of Second Generation:

® Transistors as the basic components, magnetic cores memory, Mag-
netic tapesand Disks for secondary storage were used.

® Batch operating system, High-level programming Languages were used.

® They were faster, smaller, more reliable and easier to program than
previous generation systems and were used for scientific and commer-
cial applications..

® Commercial production of second generation computers was still difficult.
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® They were costly.

® They were smaller in size and generate less heat as compared to first
generation computers.

® They consumed less electricity as compared to first generation com-
puters.

Names of Second Generation Systems:

® IBM 7030

® UNIVAC LARC.

7.4.3 Third Generation (1964-1975) :

The time period of third generation was 1964-1975.The third generation of
computer used Integrated Circuits (IC's) in place of transistors. A single IC has
many transistors, resistors and capacitors along with the associated circuitry.
The IC was invented by Jack Kilby. This development made computers smaller
in size, reliable and efficient.

Figure:7.12 IC (Integrated Circuit)

In this generation, Remote processing, Time-sharing, Real-time, Multi-
programming Operating System were used.High-level languages such as FOR-
TRAN-II TO IV, COBOL, PASCAL PL/1, BASIC, ALGOL-68, etc. were used dur-
ing this generation.

Main features and characteristics of Third Generation:

® ICs with SSI and MSI technologies were used as basic components

® Larger magnetic cores memory, largercapacity disks and magnetic

tapes as secondary storagewere used.

® They used Timesharing operating system and multi-programming
operating systems.
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® They were commercially, easier to use and easier to upgrade.

® They were used for Scientific, commercial and interactive online appli-
cations.

Names of ThirdGeneration Systems:

® IBM 360/370

® PDP-8
® PDP-11
® CDC 6600

7.4.4 Fourth Generation (1975-1989)

The period of Fourth Generation was 1975-1989.The fourth generation of
computers used Very Large Scale Integrated (VLSI) circuits. VLSI circuits having
about 5000 transistors and other circuit elements and their associated circuits
on a single chip made it possible to have microcomputers of fourth generation.
Fourth Generation computers became more powerful, compact, reliable, and
affordable. As a result, it gave rise to personal computer (PC) revolution.

Figure:7.13 Microprocessors

In this generation, Time sharing, Real time, Networks, Distributed Oper-
ating System were used.All the higher level languages like C and C++, DBASE,
etc., were used in this generation.

Main features and characteristics of Fourth Generation:

® ICs with VLSI Technology and microprocessors were used.

® Semiconductor memories, larger capacity hard disks as in-built sec-

ondary storage were used.

® Magnetic tapes and floppy disks as portable storage media were used.

® Operating systems for PCs with GUI and multiple windows on a single

terminal screen.
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® Multiprocessing OS, UNIX operating system with C programming
language,Object-oriented design and programming were used.

® PC, Network-based and supercomputing applications were used.

® They were small, affordable, reliable, and easy to use PCs and more
powerful and reliable mainframe systems and supercomputers.

® They were totally general purpose machines, easier to produce com-
mercially and easier to upgrade.

Names of FourthGeneration Systems:

IBM PC and its clones

Apple 11

CRAY-1

CRAY-2

CRAY-X/MP

7.4.5 Fifth Generation (1989-onwards) :

The period of Fifth Generation is 1989-till date.In the fifth generation, the
VLSI technology became ULSI (Ultra Large Scale Integration) technology, result-
ing in the production of microprocessor chips having ten million electronic
components.

Figure:7.14 ULSI chip

This generation is based on parallel processing hardware and Al (Artificial
Intelligence) software.Al is an upcoming branch in computer science which
interprets means and methods of making computers think like human beings.

Al include following areas:

® Robotics.

® Game Playing.

® Development of expert systems to make decisions in real life situa-
tions.
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Natural language understanding and generation.

All the higher level languages like C and C++, Java, .Net, etc., are used in
this generation.

Fig 7.15 Robotics using Al (Artificial Intelligence)

Main features and characteristics of Fifth Generation:

ICs with ULSI technology, larger capacity main memory, hard disks
with RAID (Redundant Array & Inexpensive Disk)support are used.
Optical disks as portable read-only storage media are used.
Notebooks, powerful desktop PCs and workstations, powerful servers
and supercomputers are used.

Internet and Cluster computing is used.

Micro-kernel based, multithreading, distributed OS, Parallel program-
ming libraries like MPI & PVM ,JAVA, World Wide Web, Multimedia,
Internet applications and more complex supercomputing applications
are used.

These are portable computers, and are more powerful, cheaper, reli-
able, and easier to use desktop machines.

High uptime due to hot-pluggable components andaretotally general
purpose machines.

Easier to produce commercially and to upgrade.

Rapid software development is possible.
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Names of Fifth Generation Systems:
IBM notebooks

Pentium PCs

SUN Workstations

IBM SP/2

PARAM 10000

Points to Remember

1. Memory is the storage space in computer where data to be processed
and instructions required for processing are stored.

2. Memory capacity of a computer is the amount of data that can be
stored in the storage unit.

3. Cache memory is a very high speed semiconductor memory which can
speed up CPU.

4. Primary memory holds only those data and instructions on which
computer is currently working.

5. RAM stands for Random Access Memory.
6. ROM stands for Read Only Memory.

7. The surface of disk is divided intoa number of invisibleconcentric
circles called tracks.

8. Each track of a disk issubdivided into small portions known as sec-
tors.

9. In computer terminology,Generationis a change in hardware as well
as software technology of computer.

10. External Memory is also known as secondary or auxiliary memory or
non-volatile

FEX&@U@@@@‘.H

1. Fill in the blanks:

1. A group of bits is called byte
(@ 8 (b) 16
(c) 32 (d) 64
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A bit or a binary digit may be represented by logical and

(@ 0,1 (b) 0,0

(0 1,2 (d) 1,1

RAM stands for

(a) Read Access Memory (b) Random Access Memory
() All of these (d) None of these

ROM stands for

(@) Read Only Memory (b) Random Only Memory
() Read Open Memory (d) None of these

Each track of a disk issubdivided into small portions known as

(a) Sector (b) Area

(c) Disk (d) Tape

2. True/False:

1.

s wN

Group of 8 bits is called Giga Byte

Main memory is faster than Cache memory

PROM stands for Programmable Read only Memory

EPROM stands for Erasable and Programmable Read Only Memory

The surface of disk is divided into a number of invisible concentric
circles called tracks

3. Short Answer type Questions :

s WD

5.

Name the types of Memory.

Name the various types of ROM

Main features and characteristics of First Generation:
Names of FourthGeneration Systems

Write the areas which are included in Al.

4. Long Answer type Questions:

1.

AN

Explain the External Memory.

Explain the Characteristic of Secondary Memory.
What are Tracks?

What are Sectors?

Explain Fifth Generations Of Computer.
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PREFACE

Punjab School Education Board has been updating the school level syllabi
compatible with modern approach and latest reasearch. The previously writ-
ten text-books are in continuous process of revision according to the latest
syllabi. The Board has also launched a special derive to prepare new text
books as per latest National Policies in this regard. The present book is a part
of this rpestigious program.

The knowledge in the subject of Computer Science is the need of the hour
because its study is essential for enhancement of eficient usage of Science and
Technology in every field of modern era. Computerization of every department
is done to keep it updated light of all round development of Information Tech-
nology and Communication. The knowledge of Computer Education as well as
usage of internet is necessary for everyone to have latest information about
different departments, to avail facilities of E-Ticketing etc.

Keeping in view of these requirements Punjab School Education Board has
introduced Computer Science as a compulsory subject at Elementary and Sec-
ondary levels as per guidelines of Punjab Government. This subject is already
being taught bhy PICTES in some Government Schools. The present book is
English translation of its Punjabi version prepared according to revised sylla-
bus on the demand of teachers. Every effort has been made to include each
requisite information regarding the subject in this book. I hope it will be useful
for students and teachers.

All suggestions for the improvement of the book will be highly appreciated.

Chairperson

Punjab School Education Board
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